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Creating and Managing Client Bills

Billing is an important parts of your practice. After all, it's how you are paid for the
services you provide. Morningstar Office®™ Cloud offers customizable, step-by-step
processes to handle your billing.

This manual walks through the billing cycle end-to-end, and explains the

following topics:

» Creating Management Fees (page 6)

» Assigning Management Fees (page 24)
» Calculating Management Fees (page 33)
» Generating Billing Reports (page 40)

» Billing by Groups (page 45)

» Additional Billing Tasks (page 51)

Privterl on 4/10/2018

Fageicil

Billing Summary 1/1/2018 - 3312018 AMITA MONIE
Report Curency: USD
AMITA MONIE
340 COBEK COURT
MCKINNEY, 1D 33609
Billing Details
Management Fees Bilable Balance  Period Effective Rate (%)* Billing Date Amount
Quarterly management fee for 3/31/2018 12,008.54 (.499978 Inf2ne 60.04
From to Annual Rate (%] Amount
0.00 12,008 54 2.0000 60.04
Management Fee B0.04
Account Name Account Owner  Account Mumber Market Value Billable Bzlance Ampunt
Quarterly management fee for 3/31/2018
545123236 - ROTH IRA MONIE, AMITA 545123236 198.32 2.356.17 11.78
573137281 - TRADITIONAL IRA MONIE, AMITA 573137281 1,148.02 3,485.95 17.43
5741733497 - INDVIDUAL MONIE, AMITA 574173997 1,764.01 6,166.42 30.83
Total Amount 60.04
The following amount(s) will be debited from your account(s):
Account Name Account Owner Account Number Amount
545123236 - ROTH IRA MONIE, AMITA 545123236 178
573137281 - TRADITIOMAL IRA MONIE, AMITA 573137281 1743
574173847 - INDIVIDUAL MOMIE, AMITA 574173097 3083
Total Balance Due 0.00

Overview

A typical Billing Summary

MORNINGSTAR
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Creating Management Fees

Overview

Creating Management Fees

The first step in the hilling process is to create management fees, or determine how
you want to bill your clients. For example, do you want to bill using multiple tiers,
quarterly, and in advance? Or do you want to bill with a single tier, monthly, and at the
end of term?

In this section, you will learn how to do the following:

» What a management fee is (page 6)

» Create a billing disclosure (page 7)

» Create a Total Account Value management fee (page 8)

» Create a Security Type management fee (page 13)

» Create a Flat Dollar Amount management fee (page 16)

» Create a Based on Performance management fee (page 19)
» Copy a management fee (page 22)

Management fees determine how your clients are to be billed. Once created, you can
then assign management fees to your clients, accounts, and practice. The table below
describes the three types of management fees:

With this management fee ... You can charge ...

Total Account Value A unique percentage, based on total value of
the account.

Security Type A unique percentage, broken down by security
types within an account.

Flat Dollar Amount A set dollar amount, set up for a client or account.

Based on Performance A set percentage of all portfolio gains.

Overview

What is a
management fee?

Marningstar Office Cloud January 2021
MmHNlNGSTAH © 2021 Morningstar. All Rights Reserved.



Creating Management Fees

How do | create a billing disclosure?

Billing disclosures allow you to provide additional information about your clients’ bill.
You have the option to create multiple billing disclosures, which you can assign to

How do | create a
billing disclosure?

separate management fees. Billing disclosures appear at the bottom of your client’s

bill. To create a billing disclosure, do the following:

1. From the Account icon, select Global Settings. The Global Settings window opens.

MAORNINGSTAR Office =

[ Q. Search for Clients, Securities, Reports, and Research

Practice Management Reports

Gain insights info your practice by starting a spreadsheet repart on:

Your assets under /T Your practice’s overall _7
management [ O ) performance =)
Clients [# Creats Lists & Screens

4 We found 4 data issues today. (05/08/2020]

Unrealized gains & losses
for all your clients

Click here to start.

2. Click the Billing page, then scroll down to the Fee Disclosure Management section.

3. From the drop-down field, select Create New Disclosure.

Global Settings

Genera
Data Format No Fee v
Calculation

mpgrsonation Effective Rate Decimal Setting
Set the number of decimals you want to display for the Effective Rate in yaur Billing Summary report

> |
2 Decimals v

Fee Disclosure Management

summary report, go to Fee Management in Biling.

No disclosure statement v

This is where you can create or edit disclosures that explain the fees being charged 1o your clents. Toassign a disclosure to a specific fee in your billing

Billng d

My New Disclosure

ureBilling disclosure

Select this option.

Marningstar Office Cloud January 2021
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Creating Management Fees

How do | create a billing disclosure?

4. In the Enter a name for your disclosure field, enter a name for your disclosure.

5. Inthe Enter or paste text for you disclosure field, enter content for your disclosure.

Global Settings

General

Data Format
Calculation
mpersonation

Client Accounts

Reparting

Default Management Fee
This is the fee that will be used for any new clients that are added to your practice. To customize management fees per client, go to Billing

No Fee v

Effective Rate Decimal Setting

Set the number of decimals you want to display for the Effective Rate in your Billing Summary report.
2Decimals v

Fee Disclosure Management

This s where you can create or edit disclosures that explain the foes being charged to your clients. To assign a disclosure to a specific fee in your billing
summary report, go ta Fee Management in Billing

Billing Disclosure

1

You have chosen to have fees automatically deducted from your custodian accounts

Enter a name and
text into these fields.

6. Click Create.

How do | create a total portfolio value fee?

To create a Total Portfolio Value management fee, do the following:

1. From the Menu, select Billing. The Billing page opens.

Home

EXPLORE

Merningstar Research

Markets

CLIENT MANAGEMENT & ANALYSIS

Clients & Accounts

MARNINGSTAR Office =

ch for Clients, Securities, Reports, and Research...

PRACTICE MANAGEMENT

ats
Prospects
Billing arting a spreadshest report on:
Hetia Sl > Your practice's overal Unrealized gait
» Reporting [ ] performance for all your clie

» Workspace

ntegrations [# Create Lists & Screens |
port Market Value Name Type 14
Securities — —
$4,163 471.08 My New List List |
1 Current Statement List |
Sustainable Landscape U.S List |

2 90¢ con on R e Fom

Click here to start.

Billing

Current Billing

0/3 5 Q 2

¥ Name

» AVIE HERRINGE

Name Billing Period Days in Billing Period Billable Balance SUSD

Select this option.
Market W

MORNINGSTAR
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Creating Management Fees How do | create a billing disclosure?

3. In the Create fee field, enter a name for the fee.
< Note: The fee name is limited to 50 characters.

4. Click the checkmark at the right of the fee name field. The Management Fee set up
options are displayed.

As a fee name is entered,

a counter (here, 29)

indicates how many

additional characters are allowed.

Fee Management (Cancel ) m
Create fee Please name your fee to see steup and tiers options

Tiered Management FE:EiZEI |

From the How do you want to bill? drop-down menu, select By Total Portfolio Value.

In the Fee Structure area, click Annual Rate with Firm & Advisor Fee Breakout.

In the Rate Calculation area, click Use graduated rate based upon tier breakpoints.

In the row for Tier 1, the Low Value $ field is preset at 0.00. In the High Value $ column,
enter 500,000.

9. In the Firm Fee% column, enter 2. Then in the Advisor Fee% column, enter .5.
< Note: If you selected Annual Rate Only from the Fee Structure options, only the Annual Rate
% column is available.
10. In the row for Tier 2, the Low Value $ field is preset at 500,000. In the High Value $
column, enter 1,000,000.
11. In the Firm Fee% column, enter 1.5. Then in the Advisor Fee% column, enter .5.

12. In the row for Tier 3, the Low Value $ field is preset at 500,000. In the High Value $
column presets the final tier as a series of 9's.

13. In the Firm Fee% column, enter 1. Then in the Advisor Fee% column, enter .5.

How do you want to hill? * Reguired field

By Tatal Partfalio Value v

Select this option.

Fee Structure Rate Calculation

|—| .-),

Set Up Tiers * Required figld

Choose this Fee Structure.

These rates apply 1o the total value of the account based on the rate calculation you selected

Low Value § High Value §* Hrm Fee %* Advisor Fee %* Annual Rate%

TIER 1 0.00 | 500.000.00 2.0000 0.5000 2.5000

Tien 2 50000000 | 1,000,000.00 1.5000 05000 2 y;heetizarteﬂ:;ég sslgh
TIER 3 1,000,000.00 9,999,099,099 93 1.0000 05000 15000 Tier 2's LO\?/ Value

+ Add Anather Tier

Bill Rate Methodology Bill Frequency Pay Period When to Bill

Morningstar Office Cloud January 2021 9
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Creating Management Fees

How do | create a billing disclosure?

14. In the Billing Period area, select from the various billing settings. See the table below for
a description of each option within the Billing Period area.

Billing Period o
When to Bill Eill Using Frequency Upcoming Billing Periods
(O In Advance Quarterly V) L
@ End of Term Daily Average Balance
- ) Next Billable Date Select the
® Ending Balance O Default April 1- June 30 appropriate
O Manth End Average Balance @ Custom settings.
December W
End of manth v
Bill Rate Methodology
@ Actual/Bverage
) Actual/Actual
Setting Description
When to Bill Choose either Advance to bill on the last day of one time period for the next period. Or End of
Term to hill on the last day of one time period for the same time period.
Bill Using When billing in advance, choose:
» Beginning Balance
» Daily Average Balance
When billing end of term, use:
» Ending Balance
» Daily Average Balance
Frequency Frequency refers to how often clients are billed. Select from the following options:

Quarterly
Monthly

Every 2 months
Every 4 months
Semi-annually, or
Annually.

vy vV vV VvV VvV VY

Next Billable Date

Select Default or Custom.
With Default, accounts are billed according to conventional calendar periods.

With the Custom option, accounts are charged on a date of your choosing. The start and end
dates follow your custom schedule. For example, you can stagger your quarterly billing by
scheduling a portion of your business in January (for January-March, April-June, July-September
and October-December), then create another management fee setting for the next portion in
February (for February-April, May-July, August-October and November-January), and a third
management fee setting for the final portion in March (for March-May, June-August,
September-November and December-February).

MORNINGSTAR
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Creating Management Fees How do | create a billing disclosure?

Setting Description

Upcoming Billing Periods | This field displays the billing periods you selected.

Bill Rate Methodology Select either Actual/Average or Actual/Actual.

With Actual/Average, the annual fee is multiplied by (1/4) to calculate a quarterly fee, (1/12) fora
monthly fee, etc. (The frequency of payment is selected in the Payment Period field.)

With Actual/Actual, the annual fee is multiplied by X divided by 365 (where X is the actual
number of days in the billing period) to calculate the fee. For example, with a quarterly fee, in the
second calendar quarter (i.e., April, May and June) a flat fee of $1,000 would be multiplied by
(91/365).

15. In the Additional Settings area, select from the various billing settings. See the table
below for a description of each option within the Additional Settings area. You might
need to scroll down to see all of the Settings area.

Additional Settings

Exclude Accrued Interest Adjustments

@ Ves

QO No
Select the
appropriate

lin. Flow for Praration settings.
Annual Additional Fee Annual Minimum Fee
0.00 0.00
Management Fee Billing Disclosure
@ Deduct From Custadian No disclosurs statament v
Account
(O Send Invoice to Client
Setting Description

Exclude Accrued Interest | Check Yes to exclude accrued interest from bonds in the billable balance of your accounts.

Adjustments Click the slider next to Rebate Transaction Commissions and/or Rebate Transactions “Other”
Fees.

With Rebate Transaction Commissions, any commissions you have earned over the quarter are
subtracted (this data is drawn from the transaction history).

With Rebate Transactions “Other” Fees, any transaction fees or other expenses that the client
paid to other parties (not the advisor) are subtracted.

Morningstar Office Cloud January 2021 1"
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Creating Management Fees

How do | create a billing disclosure?

Setting

Prorate

Description

Click the slider next to New Accounts and/or Cash Flows.
With New Accounts:

» If you are billing in arrears, clients will be discounted for the days during the last quarter when
their accounts were not yet open.

» If you are billing in advance, clients will be additionally charged for the days that their
accounts were open during the past quarter.

With Cash Flows, clients are discounted for the days when their accounts had a lower balance,
and charged more for the days during which their accounts had a higher balance. Once selected
In Flows to prorate for inflows only, or All Flows to prorate for both inflows and outflows of cash.

Min. Flow for Proration

Select either Amount or Percent required to trigger the proration, then enter that value in the field
below the option buttons.

Annual Additional Fee

If you need to charge an additional flat fee along with the tiered fee, enter that amount here.

Annual Minimum Fee

Enter a dollar amount here to ensure that a certain annual minimum fee is charged to an account.
Keep in mind that this fee is calculated for each billing period, and not simply at the end of the
year. For instance, if you bill quarterly and enter an annual minimum fee of $1,200, the system
will ensure your client is billed for at least $300 each quarter. If you bill monthly, the system will
ensure your client is billed for at least $100 each month.

Management Fee

Select either Deduct From Custodian Account or Send Invoice to Client.

With Deduct From Custodian Account, a 0 will appear at the bottom of the bill. Fees are deducted
from the custodian, and show up as transactions the next time transactional accounts are
deducted

With Send Invoice to Client, an amount appears at the bottom of the bill and clients must remit
payment to you.

Billing Disclosure

If desired, select a custom disclosure to appear on the Billing Summary. You must have already
created and saved a billing disclosure before you can select it here. Billing disclosure are created
within Global Settings, under the Account menu.

16. At the bottom of the Fee Management window, click Create.

MORNINGSTAR
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Creating Management Fees How do | create a security type fee?

To create a Security Type management fee, do the following: How do | create a

i ?
1. From the Menu, select Billing. The Billing page opens. security type fee?

MAORNINGSTAR Office <=

Marningstar Research

Rl ch for Clients, Securities, Reparts, and Research...

CLIENT MANAGEMENT & ANALYSIS

Clients & Accounts

ats
Prospects
Billing arting a spreadsheet report on: .
- Click here to start.
Redtell CAM T Your practie’s overal 7 Unrealized gait
» Reporting [ ] performance = for all your clie
PRACTICE MANAGEMENT
e [# Create Lists & Screens |
ROt Market Value Name Type 1
Securities —
My New List List |
Current Statement List I
Sustainable Landscape U.S List |
Linh Dosad |

Billing
Current Billing

0/5Selecred QO [2

Select this option.

¥ Name | Name Billing Period Days in Billing Period Billable Balance SUSD Market Wi

| > AVIE HERRINGE - = =

3. In the Create fee field, enter a name for the fee.
< Note: The fee name can have no more than 50 characters.

4. Click the checkmark at the right of the fee name field. The Tier SetUp options
are displayed.

As a fee name is entered, a counter
(here, 37) indicates how many
additional characters are allowed.

Fee Management

Create Fee

Security Type]

(¥}
]
H

Morningstar Office Cloud January 2021 13
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Creating Management Fees How do | create a security type fee?

From the How do you want to bill? drop-down menu, select By Security Type
In the Fee Structure area, click Annual Rate with Firm & Advisor Fee Break Out.

In the Rate Calculation area, click Use graduated rate based upon tier breakpoints.

In the Tier Group area, click Create a Tier Group. The Create a Tier Group page opens.

How do you want to bill?

|B-; Security Type 4 |

Fee Structure
@ Annual Ratz Only

Select this option.

Rate Calculation

Choose this Fee Structure.

Click this button.

9. Inthe Create a Tier Group text field, type Cash.

10. In the Search for Security Type field, type Cash. Then select Cash & Cash Equivalents.
Click off the drop-down menu to close.

(<) Back | Create a Tier Group

Tier Group Name *
This name will also be visible on your hilling reports.

| Cash |

Type a name for
the tier group here.

Add Security Types Set Up Tiers
These rates will only apply to the security types you've added 1o the left
| e o | Type a name for
1 Low Value § High Value §* Annual Rate %* the tier group here.
| Cash and Cash Equivalents |
TIER 1 0.00 Enter a number Enter a number
Add Anather Tier

11. In the row for Tier 1, the Low Value $ field is preset at 0.00. In the High Value $ column,
enter a series of 9s.

12. In the Firm Fee% column, enter 0. Then in the Advisor Fee% column, enter 0.

< Back | Create a Tier Group

Tier Group Name *
This name will also be visible an your billing reports.

Cash
Add Security Types Set Up Tiers
€L Search for ity Tvoe These rates will only apply to the security types you've added to the left
Security types you've added Low Value § High Value §* Annual Rate %*
TiER | 000 899939999393 0.0000 St s et

Cash and Cash Equivalents

Add Another Tier

Morningstar Office Cloud January 2021 14
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Creating Management Fees How do | create a security type fee?

13. In the Create a Tier Group text field (now called Cash), type All Other Securities.
14. Click inside the Search for Security Type field. A drop-down menu opens.

15. Click Add Remaining. Then click off the drop-down menu to close.

(© Back ‘ Create a Tier Group

Tier Group Name =
This name will also be visible on your billing reports.

I All Other Securities I
Type a name for
Add Security Types Set Up Tiers the tier group here.
0e These rates will only apply to the security types you've added to the left
Low Value § High Value §* Annual Rate %*
TIER 1 0.00  9999,399,939.99 0.0000
Add Anather Tier

‘Add Remaini . . .
Click this option.

16. In the row for Tier 1, the Low Value $ field is preset at 0.00. In the High Value $ column,
enter 500,000.

17. In the Firm Fee% column, enter 2. Then in the Advisor Fee% column, enter .5.

< Note: If you selected Annual Rate Only from the Fee Structure options, only the Annual Rate
% column is available.

18. In the row for Tier 2, the Low Value $ field is preset at 500,000. In the High Value $
column, enter 1,000,000.

19. In the Firm Fee% column, enter 1.5. Then in the Advisor Fee% column, enter .5.

20. In the row for Tier 3, the Low Value $ field is preset at 1,000,000. In the High Value $
column represents the final tier as a series of 9's.

21. In the Firm Fee% column, enter 1. Then in the Advisor Fee% column, enter .5.

© Back ‘ Create a Tier Group (" cance m

Tier Group Name * * Required field
This name will also be visiole on your biling reports.

All Other Securities

Add Securi Set Up Tiers

These rates will or

pply to the securty types you've added to the left

Security types you've added High Value §* Firm Fee %~ Advisor Fee %*  Annual Rete%

500.000.00 2.0000 0.5000
1,000,000.00 15000 0.5000

uivalens

Enter tiers here.

9,999,999,999.99 1.0000 0.5000

22. Click Done.

23. Follow steps 15-17 in How do | create a total portfolio value fee? on page 8.

Marningstar Office Cloud January 2021 15
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Creating Management Fees

How do | create a flat dollar amount fee?

To create a flat dollar amount management fee, do the following:

How do I create a flat
dollar amount fee?

1. From the Menu, select Billing. The Billing page opens.
Home
EXPLORE i (3
MOMNGSAR Office
Rl ch for Clients, Securities, Reports, and Research...
Clients & Accounts hets
Prospects
i E\;:g‘ — arting a spreadshest report on: il i@ i@ i
atall L Py Your practice’s overall /LN Unrealized gait
st { "/) perlnrmance (7~ |ma||your!ine
ntegrations [# Create Lists & Screens [
LD Market Value Name Type L4
Securities —
My New List List |
Current Statement List |
Sustainable Landscape U.S List |
2.
Billing
Current Billing
0/5Selecred Q0 [ q Per
Select this option.
¥ Name |Na me Billing Period Days in Billing Period Billable Balance SUSD Market W
_| _» AVIE HERRINGE e =
3. In the Create fee field, enter a name for the fee.
< Note: The fee name can have no more than 50 characters.
4. Click the checkmark at the right of the fee name field.
Fee Management (  Done )
Create Fee
Flat Management Fee| 3': Type a fee
; i named here.
10% Proration
Marningstar Office Cloud January 2021 16
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Creating Management Fees

How do | create a flat dollar amount fee?

5. From How do You wan to bill?, select By Flat Dollar Amount.
6. Inthe Annual Fee Amount field, type a 500.00 in the text box.

7. Inthe Bill Period area, select from the various billing options. See the table below for a

detailed description of

each setting.

8. Inthe Additional settings area, select from the various options. See the table below for a

detailed description of
Settings area.

each setting. You might need to scroll down to see all of the

How do you want to bill?

| By Flat Dollar Amount v |

Annual Fee gmount*

* Required field

[ 5000000 |

Select a flat
annual fee here

Billing Period

When to Bill

) In Advance

@ End of Term

Bill Rate Methodology Frequency Upcoming Billing Periods

@ Acual/dverage Quarteriy b

) Actual/Actua

MNext Billeble Date

Default

O Custom

Additional Settings

Exclude Accrued Interest Management Fee Billing Disclosure
® e ® Deduct From Custodian No disclosure statement v
o Account
nd Cli
Setting Description
When to Bill Choose either Advance to bill on the last day of one time period for the next period. Or End of

Term to bill on the last day of one time period for the same time period.

Bill Rate Methodology

Select either Actual/Average or Actual/Actual.

With Actual/Average, the annual fee is multiplied by (1/4) to calculate a quarterly fee, (1/12) for a
monthly fee, etc. (The frequency of payment is selected in the Payment Period field.)

With Actual/Actual, the annual fee is multiplied by X divided by 365 (where X is the actual
number of days in the billing period) to calculate the fee. For example, with a quarterly fee, in the
second calendar quarter (i.e., April, May and June) a flat fee of $1,000 would be multiplied by
(91/365).

Frequency

Frequency refers to how often clients are billed. Select from the following options:

» Quarterly
Monthly

» Every 2 months
» Every 4 months
» Semi-annually, or
» Annually.

v

MORNINGSTAR
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Creating Management Fees

How do | create a flat dollar amount fee?

Setting

Next Billable Date

Description

Select Default or Custom.
With Default, accounts are billed according to conventional calendar periods.

With the Custom option, accounts are charged on a date of your choosing. The start and end
dates follow your custom schedule. For example, you can stagger your quarterly hilling by
scheduling a portion of your business in January (for January-March, April-June, July-September
and October-December), then create another management fee setting for the next portion in
February (for February-April, May-July, August-October and November-January), and a third
management fee setting for the final portion in March (for March-May, June-August,
September-November and December-February).

Upcoming Billing Periods

This field displays the billing periods you selected.

Exclude Accrued Interest

Check Yes to exclude accrued interest from bonds in the billable balance of your accounts.

Management Fee

Select either Deduct From Custodian Account or Send Invoice to Client.

With Deduct From Custodian Account, a 0 will appear at the bottom of the hill. Fees are deducted
from the custodian, and show up as transactions the next time transactional accounts are
deducted

With Send Invoice to Client, an amount appears at the bottom of the hill and clients must remit
payment to you.

Billing Disclosure

If desired, select a custom disclosure to appear on the Billing Summary. You must have already
created and saved a billing disclosure before you can select it here. Billing disclosure are created
within Global Settings, under the Account menu.

9. At the bottom of the Fee Management window, click Create.

MORNINGSTAR

Marningstar Office Cloud January 2021
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Creating Management Fees

How do | create a performance fee?

To create a based on performance management fee, do the following:

1.

From the Menu, select Billing. The Billing page opens.

Home

EXPLORE

MAORNINGSTAR Office <=

ch for Clients, Securities, Reports, and Research...

Marningstar Research

Markets

CLIENT MANAGEMENT & ANALYSIS

Clients & Accounts

ats
Prospects
Billing arting a spreadsheet report on: .
. - Click here to start.
Redtai CAM /7 Your practice's overall /N Unrealized gair
() s i
» Reporting [ ] performance for all your clie

PRACTICE MANAGEMENT

ntegrations [# Create Lists & Screens [

LD Market Value Name Type L

Securities —
My New List List l
Current Statement List I
Sustainable Landscape U.S List |
Linh Dosad |

How do I create a
performance fee?

Billing
Current Billing

0/5Selecred QO [2

¥ Name | Name Billing Period Days in Billing Period

| > AVIE HERRINGE - =

Billable Balance SUSD

Market Wi

Select this option.

In the Create fee field, enter a name for the fee.

< Note: The fee name can have no more than 50 characters.

Click the checkmark at the right of the fee name field.

Fee Management

Create Fee

I Performance

10% Proration

Managament Fee T_--

Type a fee
name here

From How do you want to Bill?, select Based on Performance.
In the Billing Rate %, type 1.5.

In the Apply When Performance Exceeds %, type a percentage threshold above 0%
(optional).

In the Annual Minimum Fee field, type a 500,000.

< Note: The Annual Minimum Fee will be used when its value is greater than the value of the
fee based performance.

MORNINGSTAR

Marningstar Office Cloud January 2021
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Creating Management Fees

How do | create a performance fee?

9. Inthe Bill Period area, select from the various billing options. See the table below for a
detailed description of each setting.

10. In the Additional settings area, select from the various options. See the table below for a
detailed description of each setting. You might need to screll down to see all of the

Settings area.

How do you want to bill?

Term to bill on the last day of one time period for the same time period.

Based on Performance W
Apply When Performance Exceeds Enter performance
Eilling Rate[?:* % Annugl Minimum Fee (1) based ﬂgU res here
1.50 3.00 500.00
Billing Period
When to Bill Bill Rate Methodology Frequency Upcoming Billing Periods
End of Term @ Acwal/Average Quartery W
() Aeaee Next Billsble Date Jenua
@ Default April 1 -
O Custom
Additional Settings
Exclude Accrued Interest Management Fee Billing Disclosure
® ves ® Deduct From Custodian No disclosure statement v
Setting Description
When to Bill Choose either Advance to bill on the last day of one time period for the next period. Or End of

Bill Rate Methodology

Select either Actual/Average or Actual/Actual.

With Actual/Average, the annual fee is multiplied by (1/4) to calculate a quarterly fee, (1/12) fora
monthly fee, etc. (The frequency of payment is selected in the Payment Period field.)

With Actual/Actual, the annual fee is multiplied by X divided by 365 (where X is the actual
number of days in the billing period) to calculate the fee. For example, with a quarterly fee, in the
second calendar quarter (i.e., April, May and June) a flat fee of $1,000 would be multiplied by

(91/365).

Frequency

Frequency refers to how often clients are billed. Select from the following options:

» Quarterly
Monthly

» Every 2 months
» Every 4 months
» Semi-annually, or
» Annually.

v

MORNINGSTAR

Marningstar Office Cloud January 2021
© 2021 Morningstar. All Rights Reserved.

20



Creating Management Fees How do | create a performance fee?

Setting Description

Next Billable Date Select Default or Custom.
With Default, accounts are billed according to conventional calendar periods.

With the Custom option, accounts are charged on a date of your choosing. The start and end
dates follow your custom schedule. For example, you can stagger your quarterly hilling by
scheduling a portion of your business in January (for January-March, April-June, July-September
and October-December), then create another management fee setting for the next portion in
February (for February-April, May-July, August-October and November-January), and a third
management fee setting for the final portion in March (for March-May, June-August,
September-November and December-February).

Upcoming Billing Periods | This field displays the billing periods you selected.

Exclude Accrued Interest | Check Yes to exclude accrued interest from bonds in the billable balance of your accounts.

Management Fee Select either Deduct From Custodian Account or Send Invoice to Client.

With Deduct From Custodian Account, a 0 will appear at the bottom of the hill. Fees are deducted
from the custodian, and show up as transactions the next time transactional accounts are
deducted

With Send Invoice to Client, an amount appears at the bottom of the hill and clients must remit
payment to you.

Billing Disclosure If desired, select a custom disclosure to appear on the Billing Summary. You must have already
created and saved a billing disclosure before you can select it here. Billing disclosure are created
within Global Settings, under the Account menu.

11. At the bottom of the Fee Management window, click Create.

Morningstar Office Cloud January 2021 21
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Creating Management Fees

How do | copy a management fee?

You can also copy a management fee you've already created. Once copied, you can
then make changes to the fee. To copy a management fee, do the following:

1. From the Menu, select Billing. The Billing page opens.

Home

EXPLORE

MAORNINGSTAR Office <=

ch for Clients, Securities, Reports, and Research...

Morn

Markets

CLIENT MANAGEMENT & ANALYSIS

Clients & Accounts

ats
Prospects
Billing arting a spreadshest report on: .
- Click here to start.
Hetaiei > Your practie's overal (57 Umealied i
» Reporting L) performance W/} ferallyour clie
PRACTICE MANAGEMENT
> Workspace
egrations [# Create Lists & Screens [
W Market Value Name Type
Securities

Search for Clients. Securities, Reparts, 2
Current Billing

0/58elected QL [

How do | copy a
management fee?

¥ Name Name Billing Period Days in Billing Period

Billable Balance SUSD

Market Wi

Select this option.

| > AVIE HERRINGE T =

3. Hover the cursor over the row of the management fee you want to copy. The Actions
icon appears. Click the Actions icon. The Actions menu opens.

4. From the Actions menu, select Duplicate. A new row appears.

Fee Management

Create fee

5

Actions Select or create a new fae

Select this option

Marningstar Office Cloud January 2021
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Creating Management Fees How do | copy a management fee?

5. Inthe text box, type a name for your duplicate management fee. Then click the check
mark next to the text box.

Fee Management

Create fee How do you want to bill? 1
By Total Portfolio Value v
Ed - B
d Fee Structure Rate Calculation Name the
O Use fiat rate based on duplicate fee here.
highest tier met

® Use graduated rate
based on tier breakpoints

Set Up Tiers 1

These rates apply to the total value of the account based on the rate calculation you selected

Low Value § High Value §* Firm Fee %* Advisor Fee %* Annual Rate%
TiER 1 000 50,000.00 0.0000 3.0000 3.0000
TiER 2 50,000.00 100,000.00 0.0000 1.0000 1.0000
TIER 3 100,000.00 300,000.00 0.0000 0.0500 0.0500
TIER 4 300,000.00 Enter a number 0.0000 0.0100 0.0100
~+ Add Another Tier
Billing Period

6. Change any of the setting within the Fee Management settings options, then
click Create.

Fee Management

Create fee How do you want to bill? 1
By Total Portfolio Value A%
- B

Fee Structure Rate Calculation

highes

® Use graduated rate
based on tier breakpoints

Set Up Tiers 1

These rates apply to the total value of the account based on the rate calculation you selected

Low Value § High Value §* Firm Fee %* Advisor Fee %* Annual Rate%
TiER 1 0.00 50,000.00 0.0000 3.0000 3.0000
TIER 2 50,000.00 100,000.00 0.0000 1.0000 1.0000
TIER 3 100,000.00 300,000.00 0.0000 0.0500 0.0500
TIER 4 300,000.00 Enter a number 0.0000 0.0100 0.0100

~+ Add Another Tier

Click here to
create the new fee

Billing Period

Marningstar Office Cloud January 2021 23
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Assigning Management Fees

Overview

Assigning Management Fees

After you create your management fees, you can assign them to clients. For each client
or account, assign the following settings:

» management fee

» fee methodology

» discount (optional), and
» fee allocation.

In this section, you will learn how to do the following:

apply a fee calculation methodology (page 24)

assign a management fee to a client or account (page 26)

assign a management fee to multiple accounts (page 28)

assign management fees using an administrator account (page 29)
assign a management fee at the practice level (page 30)
understand how management fees are paid (page 30), and

apply an ongoing discount to a client or account (page 32).

vVvyVvVTVvyVvVvyyywy

Before assigning the management fees you created, you must first select a fee
calculation methodology. The fee calculation methodology determines how fees are
calculated. You can calculate billing fees in the following ways:

Fee Methodology Definition

Client Aggregate Aggregate all of a client's accounts into a single
portfolio, and apply a single management fee to the
aggregate.

Individual Account Apply a management fee to each account
individually.

Blended Rate Apply separate management fees to different
accounts, but change each account based on the
size of the entire aggregate.

At the client-aggregate level, all of a client’s accounts are aggregated into one bill. At
the individual account level, each account receives a separate bill.

Based on the methodology you choose, assign management fees at that level. To
assign a fee methodology, do the following:

1. Onthe Billing page, hover the cursor over the row of a client. The Actions icon is
displayed.

2. Click the Actions icon to display the Actions menu.

Overview

How do I apply
a fee calculation
methodology?

Marningstar Office Cloud January 2021
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Assigning Management Fees How do | apply a fee calculation methodology?

3. From the Actions menu, select Edit Billing Settings. The Edit Billing Settings
window opens.

Billing

Current Billing

0/5 Selected O [

> Hame Account Number Billing Group Name ~ Billing Period Days in Billing Period

» AVIE HERRINGE &l - -
=] » Brian Lav " -
"] » COSTALKASSNER  ClientActions =

—| > DoeJon =
4' Edit Billing Settings I

~| » Lola Bunny

Note the highlighted selections

Calculate Fees

Generats Report

4. From the Fee Calculation Methodology drop-down menu, select the methodology you
want to use.

Edit Billing Settings: ABEL COLEBROOK (—Canest )

Cliont's Management Fee Setting

Fee Allocation Fee Discount % (Optional)

% 10 tach Account v 0.00

Make your
selection here.

Account Number  Fee Allocation %
0.00
000 (@ 01/30/2018 MM /DD/YYYY
0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00
Total 0.00

< Note: Do not click Done.

Morningstar Office Cloud January 2021 25
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Assigning Management Fees How do | assign a management fee to clients and accounts?

Now that you've created several management fees, the next step is to assign a How do | assign

management fee to your clients and accounts. Management fees can be assigned at a management fee

the following levels: to clients and accounts?
> practice

» multiple clients
» client aggregate
» individual accounts.

This section describes how to assign a management fee to a clients and accounts. Do
the following;

1. On the Billing page, hover the cursor over the row of a client. The Actions icon is
displayed.

2. Click the Actions icon to display the Actions menu.

3. From the Actions menu, select Edit Billing Settings. The Edit Billing Settings
window opens.

Billing

Current Billing »~

O [ | O Sselect By Accoun

0/5 Selectad

=)
o

P Name Account Number Billing Group Name Billing Period Days

—| » AVIE HERRINGE s
| w Brian Lav o
] »COSTALKASSNER  ClientActions

» Doe.Jon I

» Lola Bunny

in Billing Period

Note the highlighted selections

4. To assign at the client aggregate level, from the Fee Calculation Methodology
drop-down menu, select Client Aggregate.

5. From the Client's Management Fee drop-down menu, select the management fee you
want to use.

Edit Billing Settings: ABEL COLEBROOK (— Caneal )

Client's Management ree Setting

Fee Atlocation ee Discount % (OptionsD Make your
0.0 selection here.

- 564787123 ROLLOVER 1AA

000 (@ 01/30/2018 MM /DD/YYYY

Morningstar Office Cloud January 2021 26
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Assigning Management Fees How do | assign a management fee to clients and accounts?

6. To assign at the individual account level, from the Fee Calculation Methodology
drop-down menu, select Individual Account.

For each individual account, from the Management Fee drop-down menu, select the
management fee you want to use.

Edit Billing Settings: ABEL COLEBROOK

Cancel ) Save

Client's Management Fee Setting

Fee Calculation Methodology

I Individual Account v I

Fee Allocation Fee Discount % (Optional)

% to Each Account v

Accounts

Include in

Billng Discount% Afer fst Make your
Calculation  Name AccoNNumber  Management Fee Setting {Optional)  Fee Allocation % Transaction  Billing Start Date Billing End Date selection here.
o 1 000

@ 7143 - ROLLOVER IRA Use Client Defeult Settings 000 1 @ 01/30/2016 MMVDD/YYYY

@ BINOY Use Client Default Settings v 000 000

Marningstar Office Cloud January 2021
MCORNINGSTAR
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Assigning Management Fees

How can | assign a single account fee to multiple accounts?

Suppose your firm has changed the fee structure for traditional IRAs, and many of your
clients have IRA accounts. You can change the account fee for multiple accounts.

Do the following:

1.

el

From the Menu, select Billing. The Billing page opens.

At the upper-left corner of the window, make sure Current Billing is selected.

Click the slider next to Select By Accounts.

In the list, select accounts by clicking the checkbox at the beginning of each row for an

account whose billing fee you want to change.

< Note: The accounts can be from different clients.

— Men Billing

Current Billing

0/24 Selected ;4 4 (_® Select By Account]

Actions v

v

Name

Account Number

v

Albert Einstein

Albert Einstein

1234657

Bob Barker - IRA

35637377

O 0o

Hans Albert Einstein

Martha Einstein

8904537

28785523 Note the highlighted selections.

v

Alexander Hamilton
401K

IRA

\..il\.\

Taxable

v

Anderson Family
Aaron's Taxable
Anderson Account
Anderson Joint Account

Anderson Joint Account2

947775113
88210987

Baker Household

Baker Aggregate

Baker IRA Account

20081004

)< || ]

Baker Transactional Account

20082002

<

Chris Bayly

IRA

| O|@

XYZ 401(K) Statement

¥V7 Rrakarana Arranint

How can | assign a
single account fee
to multiple accounts?

MORNINGSTAR

Marningstar Office Cloud January 2021
© 2021 Morningstar. All Rights Reserved.

28



Assigning Management Fees

How do | assign management fees as an administrator?

5. From the Edit Settings menu, select Management Fee Settings.

6. From the Assign Fee menu, select a fee. The fee is saved automatically.

Billing

Current Billing

4/74 Selected :fl [ (@ Select By Accounts

Edit Account Sdttings (4)

Note the highlighted selections.

Ilanagement Fef Calculztion

8 > Name

N B/419Selected Actions v [ |

¥ AVIE HERRINGE
508103357 - ROTH IRA

Manzgement Fee Setting

"_‘;" Management Fee Setting

642217618 - JOINT - WITH RIGHTS OF 5

842432750 - INDIVIDUAL

In firms with multiple advisors, an administrator account may be granted to one or
more members of your firm. Administrator accounts have access to all clients within
the firm, regardless of which advisor owns clients. When it comes to billing, the

Use Client Default Sattings

newfeetest

Sample Tiered Management Fae

Sample Tiered Management Fee - copy

How do I assign
management fees
as an administrator?

administrator can assign settings, calculate fees, and create billing reports for a single

advisor or all advisors within a firm.
To assign management fees as an advisor, do the following:

1. From the Menu, select Billing. The Billing page opens.

o™

Billing

Select All Advisors or an individual Advisor within your Firm.

At the upper-left corner of the window, make sure Current is selected.

In the upper-right corner of the window, click the View By Advisor drop-down menu.

Most Recent Billin

account test =

View By

¥ Name Account Number Jroup Nam

20200WERTYUIOPASDFGHJKLZXCVBNM =

2020qwertyuiopasdfghjklzxcvbnm —

All Advisors ~/ | i

"|A" "Test11" {Admin)
K Toet19 [ rmin _| Select either all advisors
A Test12 {Admin} . )

_| orasingle advisor here
A Test13

< Note: This menu is available with administrator accounts only.

5. Setup fees for clients:

» To setup fees for a single client, follow the instruction in How do | assign

a management fee to clients and accounts? on page 26.

» To set up fees for multiple clients at once, follow the instructions inHow can | assign

a single account fee to multiple accounts? on page 28.

MORNINGSTAR
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Assigning Management Fees

How can | assign a management fee at the practice level?

In addition to assigning management fees at the client and account levels, you can
also assign a fee for your practice. This setting is applied to each new client, unless you

manually change it at the client level.

To assign a fee for your practice, do the following:

1. In the header area, click the Account icon,

window opens.

then select Global Settings. The Settings

How can | assign
a management fee
at the practice level?

The header is displayed

throughout Morningstar
Acount Office Cloud.
MORINGSTAR Office =
Client Web Portal Setup
] N File Management
Clients, Securities, Reports, and Research... e
Global Settings |
Content Catalog
EnERED i
M Market Value
¢ 202090 07
2. From the Navigation pane on the left, select the Billing tab.
3. From the Default Management Fee menu, select the management fee you want to
assign to your practice.
Global Settings Save

Fee Calculation Preferences

Choose a
management fee
from here

Genera : -

These preferences will zpply to 2l fee calculations in your practice
Data Format
i T
Calculation L include m:

Use absolut of short positions
Impersonation
Client Accounts Default Management Fee
Biling I s Thisis the fee that will be used for any new clients that are added to your practice. To customize management fees per ciient, go to Billing
Reporting

newfegtast the Effactive Rate in your Billing Summary report
Sample Tiered Managemant Fee

MORNINGSTAR

Marningstar Office Cloud January 2021
© 2021 Morningstar. All Rights Reserved.

30



Assigning Management Fees

How are management fees paid?

When creating your management fee, you determine whether you want fees deducted
from your clients’ custodian accounts, or whether you want to send each client an
invoice. If you choose to send an invoice, the client is responsible for sending payment.

If you choose to have fees deducted from a custodian account, you can allocate fees in
the following ways:

» Each account pays for itself

» Designate an account to pay for another account, or
» Assign a percentage to each account.

If each account pays its own fees, you do not need to make any changes to the Edit
Billing Settings box.

To select an account to pay fees for another account, do the following:

1. From the Fee Allocation drop-down menu, choose Select With Account Pays. The Fee

Paid By column is added to the Accounts area.

How are
management fees paid?

© 2021 Morningstar. All Rights Reserved.

2. For each account, make a selection from the Fee Paid By drop-down menu.
Edit Billing Settings: ABEL COLEBROOK nc Save
Client's Management Fee Setting
Use User Default Settings v
Fee Calculation Fee Allocation Fee Discount % (Optional
Client Aggregate 3% | Select Which Account Pays v 000
Accounts Select which
iB’\C\LdEH‘ itar.".;. ing account pays
n fter 1st
Ca cugalm' Name Account Number ~ Fee Pajd By Transaction  Billing Start Date Billing End Date fees here-
® 1763 This Account v
® 564787143 - ROLLOVER IRA 564 1783 v (] 01/30/2018 MM/DDAYYYY
@ BINOY 12 1783 v
3. Click Save.
To assign each account a percentage of the hill, do the following:
1. From the Fee Allocation drop-down menu, choose Select With Account Pays. The Fee
Paid By column is added to the Accounts area.
2. For each account, make a selection from the Fee Paid By drop-down menu.
Edit Billing Settings: ABEL COLEBROOK Ca Save
Client's Management Fee Setting
Use User Default Settings v
Fee Calculation Methodology Fee Allocation Fee Discount % (Optional)
Client Aggregate v % to Each Account v 0.00
Select the
Accounts percentage
Include in Start Billing eaCh account
?a c’:fa(or Name Account Number Fee Allocation % :‘;isa‘cs'(\:\ Billing Start Date Billing End Date pa\/S hBrB.
@ 1783 - 60.00
® 564787143 - ROLLOVER IRA 00| (e 01/30/2016 MM/DD/YYYY
® BINOY 20.00
Total 100.00
MmHNlNGS.mR Morningstar Office Cloud January 2021 31



Assigning Management Fees How do | apply a discount to a client or account?

In some cases you may want to apply an ongoing fee discount percentage to a client or
individual account. For example, you assign a management fee with a 1% annual fee
percentage to the client, then enter a discount of 25 basis points. The result? Your
client will be charged .75% annually.

How do | apply a discount
to a client or account?

Before entering a a fee discount percentage, select the appropriate fee calculation
methodology.

» To apply a discount at the client level, select Client Aggregate.
» To apply a discount at the individual account level, select individual Account.

Edit Billing Settings: ABEL COLEBROOK [ Cance Save
Client's Management Fee Setting Entera diSCOUnt
Use User Default Settings v at the client
level here.
Fee Calculation Methodology Fee Allocation Fee Discount % (Optional)
Client Aggregate v % to Each Account v 0.25
Edit Billing Settings: ABEL COLEBROOK ( Cance Save
Client's Management Fee Setting
Fee Calculation Methodalogy Fee Allocation Fee Discount % (Optional)
| Individual Account \% | % to Each Account v
Accounts
Include in Start Billing
Billing Discount % After 15t
. Calculation  Name Account Number ~ Management Fee Setting (Optional] ~ Fee Allocation % Transaction  Billing Start Date Billing End Date
Enter a discount at B
the Individual (® 1783 i Use Client Default Settings v 0.25 60.00
account |e\/e| here_ (@] 564787143 - ROLLOVER IRA 564787143 Use Client Default Settings % 000 200 (@ 01/30/2016 MM/DDAYYYY
® BINOY 123456789 Use Client Default Settings v 0.00 2000

How do | exclude an
account from billing?

To exclude an account from billing calculations, in the Edit Billing Settings box, click the
slide next to the account you want to exclude.

Edit Billing Settings: ABEL COLEBROOK (' Gance Save
Client's Management Fee Setting

Use User Default Settings v
Fee Calculation Methodology Fee Allocation Fee Discount % {Optional)

Client Aggregate v % to Each Account v 0.00
Accounts Click the slider
Include in Start Billing to eXC|Ude an
Billing After 1st illi
Calculation Name Account Number Fee Allocation % Transaction  Billing Start Date Billing End Date account fme bllllng'
® 1783 = 60.00

® 564787143 - ROLLOVER IRA 004787143 nn @ 01/30/2018 MM/DD/YYYY

@ BINOY 123456769 2000

Total 100.00

Marningstar Office Cloud January 2021 32
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Calculating Management Fees Overview

Calculating Management Fees

After creating management fees and assigning billing settings to clients, you can then Overview
calculate fees. This section describes how to calculate billing fees.

In this section, you will learn how to do the following:

» calculate billing fees (page 33)

» calculating billing fees for new clients in advance immediately (page 34)

» view historical management fees (page 36)

» export billing data to Microsoft® Excel® (page 37)

» include or exclude multiple accounts from the billing calculations (page 38), and
» learn if an account is excluded from aggregation (page 39).

When calculating fees, simply select a billing period and Morningstar Office Cloud How do |
takes care of the rest. calculate billing fees?

To calculate fees, do the following:

1. Onthe Billing page, hover the cursor over the row of a client. The Actions icon is
displayed to the right of the client name.

2. Click the Actions icon to display the Actions menu.

3. From the Actions menu, select Calculate Fees. The Calculate Fees dialog box opens.

Billing
Current Billing
0/5 Selected Q. [2 ) Selact By Accaunts | Actions Mast Recent Billing Periad
- Hame Account Number Billing Group Name ~ Billing Period Days in Billing Period
| AVIEHERRINGE [l - =
~| » Brian Lav 4 =
~|  » COSTAL KASSNER Client Actions a3,
| » DoeJon e T -
= dit Billing Settings} Rl :
» Lola Bunny = = Note the highlighted selections
culate Fees
Generate Report
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Calculating Management Fees

How can | calculate fees for new accounts in advance immediately?

4. From the Choose a Billing Period menu, select Most Recent Billing Period or Previous
Billing Period, then click Run.

Calculate Management Fees | Cancel ) m

Choose a Billing Period

|t Recent Billing Period || LastAuvailable Date is

the default selection.
Previous Billing Period

5. On the Billing page, you can see the results of the calculations.

Billing Search for C
Current Billing
0/54 Selected Q[ Bxport Al ) Select By Accounts | Actions All Advisors v Mast Recent Billing Period
Effective
» Name Account Number Rate% Fee Data Date Fee Amount USD  Billed By Billab
C] ¥ Alexander Hamilton = 0.20 04/01/2019 2,
401K 0.20 04/01/2013
IRA = 020 128393 Client
Taxable = 0.20 3.118.96 Client
") » Anderson Family - = =
) » Baker Household — — [

When billing clients in advance, you can bill new accounts immediately. New accounts
must be added during the current billing cycle that you are billing in or the previous
billing cycle, and a management fee set to bill in advance must be assigned to the new
account.

To identify accounts that were added during the previous billing cycle, from the View
by Billing period menu, change the View By Billing Period menu to Previous Billing
Period. In the Billing Start Date column, note any accounts marked as New.

Billing

Current Billing

Fee data displays here.

How can | calculate fees
for new accounts in
advance immediately?

Identify new accounts here.

0/22 Selected 2 [ @D Select By Accounts | Actions Previous Billing Period
Accoun t
Management
¥ Name Account Number ting Fee Disclosure Calculation Billing Stert/Datz Adviser Name
¥ Albert Einstein 2 Can Edit N Fees Deductible - Bryan Miller
Abert Einstein Include Bryan Mille
Include Tryan TG
uc Bryan Mil
Include
Wart Include
¥ Alexander Hamilton 82 Can Edit N =
401K p
IRA =
Taxable =5
Bayly Family - Setting - - The Advisor
¥ Haba Family = ] = — The Advisor
Chris Haba Indidua @ 6784 Include 10/28/2004 The Advisar
Currer = eting Exclug N sor
Haba I 654854 Include 0472 sar
VA 12345 a Include 07

Marningstar Office Cloud January 2021
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Calculating Management Fees

How can | calculate fees for new accounts in advance immediately?

< Note: Review Creating Management Fees on page 6 to create a management fee billing

in advance.

After assigning a billing in advance management fee, complete the following two steps
to bill a new account immediately:

» assign a hilling start date within Setup Fees; and
» select Bill immediately on new account within Calculate Fees.

To bill a new account in advance immediately, do the following:

1. For each account, From the Billing Start Date field, select Day after 1st Transaction or

type a custom Start

Date.

Setup Fees

Fee Methodology
@ Clent

ACCOUNTS

945123236 - ROTH IRA

(@ Include in Billing Calculation

573137281 - TRADITIONAL IRA

(@ Include in Billing Calculation

574173997 - INDIVIDUAL

(@ Include in Billing Calculation

Select a Fee for All Client's Accounts

Percent of Account Value v

Select a Fee

Select a Fee

Select a Fee

Account Paying Fee

545123236 - ROTH IRA v

r Y
=

After assigning all
fees, click here to save

Billing Start Date
08/01/2018 v

Account Paying Fee

573137281 - TRADITION v

Type your custom
Billing Start Date here

Billing Start Date

Account Paying Fee

574173997 - INDIVIDUAL v

Day after 1st Transaction v

Billing Start Date

Day after 1st Transaction v
"

J

2. Click Done.

3. Onthe Billing page, hover the cursor over the row of a client. The Actions icon is

displayed.

4. Click the Actions icon to display the Actions menu.

5. From the Actions menu, select Calculate Fees. The Calculate Management Fees
window opens.

Billing
Current Billing *~

0/5 Selected - [

» Hame

» AVIE HERRINGE

Account Number

Billing Group Name ~ Billing Period

Days in Billing Period

» Biian Lav

» COSTAL KASSNER
» Doe.Jon

» Lola Bunny

B -

Client Actions

Edit Billing Settings|

Calculate Fees

Select Day after 1st
Transaction here

Note the highlighted selections

Generats Report

MORNINGSTAR
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Calculating Management Fees

How do | view historical management fees?

6. From the Choose a Billing Period drop-down menu, select Previous Billing Period.

7. Slide the Billing Immediately on New Account slider to activate.

Calculate Management Fees

( Cancel jm

Choose a Billing Period

Previous Billing Period

¥ | Select this Billing Period

|\_Q Billing Immediately on New Account

) Remove New Accounts Billing in Historical

New Account

Autoclient3_Trans 1

Select this slider to bill
accounts immediately

Start Date
05/05/2020

< Note: The new account will be noted within the Calculate Management Fees window.

8. Click Run.

When you calculate fees, they apply to only the current period. However, you can view

prior management fees on the Billing page.

How do I view historical
management fees?

To view historical management fees, at the top of the Billing page, click Billing
History. the prior date management fees are displayed. You can also filter for fee
types, using the filter panel on the right side of the screen.

Billing
Billing History v | Filter Click here to view
L historical
0122 e g ) Name management fees.
Clien Current Bil ng Billing Type Date Billable Balance Effective Rate QL Search for clients, groups, & accour
Billing History v/
(] 9 Management Fee 06/30/2018 798,525.33 0
Date Range
9XAXX456 Management Fee 0 9 719,6689.33 0
Management Fee 0 ] 2731517 0 IM/D Y to
O Management Fee 0 9 26,848.82 0
O Management Fee 0673 9 179.935.75 0
O Management Fee 03/3 9 176,753.00 0
O Management Fee 0 019 217.619.05 0 Billing Type
O Management Fee 0 019 21361243 0 —
— [ Management Fee
(] Albert Einstein Management Fee 06/30/2019 2892869 28 0 -
i
] Albert Einstein IManagement Fee 03/3 9 153 0 ‘:‘ fdjustment
] Alexander Hamilton Management Fes 06/30/2019 29 0 [ Billable Services
] Alexander Hamilton Management Fee 0 9 0 [_] Senvice Charge
() Alexander Hamilton Management Fea g 0 0 [ Payments Filter for historical
(] Alexander Hamilton Adjustment 9 = fees usmg the
] Alexander Hamilton Adjustment 9 criteria here
- avandar Hamilton Adinctmant 01/30/72010 il illing | oyol
Morningstar Office Cloud January 2021 36
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Calculating Management Fees

How can | export billing data to Microsoft Excel?

At times, you might want to export a client’s or account’s billing view to Microsoft® How can | export billing

Excel® so that you can download, print, or share the information.
To export a billing view, do the following:

1. From the Menu, select Billing. The Billing page opens.

data to Microsoft Excel?

At the upper-left corner of the window, select either Current or Histerical.

2
3. Inthe Actions for area, select Clients or Accounts.
4

Select an account or client by clicking the checkbox at the beginning of its row.

Billing

0/67 Selected - [F] | (@ Select By Accounts | Actions

= ¥ Name Account Number
¥ 9XXXX4562 -
INXKKA062 GXXA562
¥ 9XXXX6911 =
INXXXEIT1 GXHKXBI11
¥ 9XXXX6986 =
IHXXKEIB6 9XXXX6986

5. Click the Export All icon. The Save As window opens.

— Menu Bill'mg

Current Billing

Note the highlighted selections.

0767 Selected QO

=. ¥ Name Account Number
¥ 9XXXX4562 -
9XXXX4562 IXXXX4562
v 9XXXX6911 =
XNXXE911 9XXXX6911
¥ 9XXXX6986 =
INXXXEIBE 9XXXX6986

Click the Export icon to
export the current or
historical billing view for the
selected client or account.

6. Navigate to a location on your system to save the exported file and click Save.
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Calculating Management Fees

How can | include or exclude multiple accounts from
the billing calculations?

You can include or exclude multiple accounts from the billing calculations. How can |

Do the following:

1.

5.

From the Menu, select Billing. The Billing page opens.

include or exclude
multiple accounts from
the billing calculations?

At the upper-left corner of the window, make sure Current is selected.

In the Actions for area, select Accounts.

Select accounts by clicking the checkbox at the beginning of row of an account to

be included or excluded.

< Note: The accounts can be from different clients.

— Menu Bill'mg

Current Billing

0/67 Selected Q. [

= ¥ Name Account Number
¥ 9XXX(4562 =
| IXXXX4562 | 9XXXX4E62
v GXXXX6911 —
| 9XHXXB911 | 9X0XXBE1 1
¥ 9XXXX6986 =
| 9XX00E386 | 90986

From the Action menu, select Include in Billing Calculation.

Note the highlighted selections.

6. From the Include in Billing Calculation menu, select Yes (to include) or No (to exclude).

Billing

Current Billing

2/24 Selected Q. [ (@ Select By Accounts

Edit Account Settings (2)

Note the highlighted selections.

MORNINGSTAR

B ¥ Name er
IManagement Fee Calculation > |

¥ 9XXXX4362 [T —————— S (_ ) Include in Billing Calculation
9XXNKATEZ i : [~

¥ 9006911
GXKXKB911 e

¥ 9XXXX6986 = -
9XXXXEI86 9XXXX69B6
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Calculating Management Fees

How can | learn if an account is excluded from client aggregation?

You can learn if an account is excluded from client aggregation without leaving the

Clients & Accounts area.

Do the following:

1. In the Clients & Accounts workbook, select the Overview worksheet.

2. From the Clients Grid, select a client.

3. Inthe Account Analysis component, scroll right to view the new column, Excluded from

Client Aggregation.

@ Note: If the account is excluded from aggregation in the desktop version of Morningstar®™

Office, itis grayed out in Morningstar Office Cloud.

— Menu  Portfolio Analysis | Clients & Accounts

Active Clients v

Q[ Export All

Name
A

¥ 9XNXX6911
900X6911

¥ 9XXXX6986
9XXXX6986

> 9XXXXB787

» Albert Einstein

1O|0|O|0 g0 e

» Alexander Hamilton

Analytical View

Overview V' Asset Allocation

Account Analysis = 08/30/2013

Name

9XAXX6911
1 9XXXXB911

Search for

Performance

Risk vs Return ~ Trans:

Jyr

actions

Since
Inception

-0.44
044

Inception Date

08/10/2018
08/10/2018

How can | learn if

an account is excluded

from client aggregation?

Exclude from
Client Aggregate

N

o

Grayed-out
accounts were
excluded from
aggregation in
the desktop
version of
Morningstar
Office.

MORNINGSTAR
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Generating Billing Reports Overview
Generating Billing Reports
Whether you choose to bill your client by invoice, or to have fees deducted from a Overview
custodian account, you can easily generate client bills and custodian files. You can also
validate whether your client holds enough cash to cover the bill.
In this section, you will learn how to do the following:
» generate a Client Billing Summary Report (page 40)
» generate a Custodian Fee Report (page 42), and
» generate an Insufficient Cash Accounts report. (page 43).
A Client Billing Summary Report is a bill that you send to the client, who is then How do |
responsible for paying it. generate a Client
. . : Billing Summary Report?
To generate a Client Billing Summary Report, do the following: g Summary Report
1. Onthe Billing page, hover the cursor over the row of a client. The Actions icon
is displayed.
2. Click the Actions icon, then from the Actions menu, select Generate Reports > Client
Billing Summary. The Client Billing Summary dialog box opens.
Billing
Current Billing
0/5 8elected 2 [ ) Select By Accounts | Actions t Billing P
| AVIEHERRINGE [l - =
~| » Brian Lav “ ey
~| » COSTAL KASSNER Client Actions ey
> Dos.Jon Edit Billing Settings -
» Lola Bunny = e -
| E ;s Note the highlighted selections
Generate Report
3. Select from the options for the following:
» Report Type
» Cover Page
» Start Date, and
» End Date.
G te Report Cancel ) m
ererate Tepe The default options
Heportilme are shown here.
@ Client Billing Summary
Start Date™ End Date®
3 Months Ago v Month End v
Billing Options
o
Deduct other fees from custodian accounts N
Cover Page
[ Include Cover Page
Other Repart Options
\:J Mask Account Number
Marningstar Office Cloud January 2021 40
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Generating Billing Reports How do | generate a Client Billing Summary Report?

4. Click Run. The report displays in a separate tab once it is finished running.

< Note: You must have your pop-up blockers turned off in order to view the report immediately.

5. From the Menu, select Reports to view the report from inside Morningstar Office Cloud.

6. Onthe Reports page, click the client name to view the report. The report opens as a PDF
in a new browser window or tab.

7. Your report is displayed at the top of the list. Click the report name to view it. A PDF of
the report opens in a new browser tab or window.

] Name Status Type Target Client Name Report Level
A
Billing Su Client 4R
g The latest Billing Summary
Account 0 Account will appear here
Snapshot Account
Snapshot Account
Pt on 4/302010 Pageio
Billing Summary 11/2018 - 3/31/2018 AMITA MONEE
Report Cumency: USD
AMITA MONIE
340 COBEK COURT
MCKINNEY, 1D 33609
Billing Details
Management Fees Billable Balance  Period Effective Rate (%) Billing Date Amount
Quarterly management fee for 3/31/2018 12,008.54 04934978 In2ms B0.04
From to  Annual Rate (%) Amount
0.00 12,008 54 2.0000 6004
Management Fee 60.04
Account Name Account Owner Account Number Market Value Billahle Balance Amount
Ouarterly management fee for 3/31/2018
545123236 - ROTH IRA MONIE, AMITA 545123236 19832 2.356.17 11.78
573137281 - TRADMIONAL IRA MOMIE, AMITA 573137281 1,148.02 3,485.95 17.43
574173947 - INDIVIDUAL MONIE, AMITA 574173997 1,764.01 6,166.42 30.83
Total Amount 60.04
The following amount(s) will be debited from your account(s):
Account Name: Account Ownes Account Number Amount
545123236 - ROTH IRA MONIE, AMITA 545123238 11.78
573137281 - TRADTIONAL IRA MONIE, AMITA 573137281 1743
574173997 - INDIVIDUAL MONIE. AMITA 574173997 3083
Total Balance Due 0.00

Morningstar Office Cloud January 2021 vy
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Generating Billing Reports

How do | create a Custodian Fee Report?

8. To send the report to the client, do one of the following:

» Download the PDF and send it to the client via email, or
» Onthe Reports page, hover the cursor over the client's row, then from the Actions
menu, select Publish to Client Web Portal.

0 Selscted

Name
i

Status

& Billing Summary
2 HeRRINGE
2 Herr

Ready

Type Client Name

Target

Billing Su HERRING

A Custodian Fee Report is a notice that is sent to the custodian, informing her that the

=A==
mom om om

5081

Report Level

Note the highlighted selections

fee is about to be deducted.

To create a Custodian Fee Report, do the following:

1. Onthe Billing page, hover the cursor over the row of a client. The Actions icon is

displayed.

2. Click the Actions icon, then from the Actions menu, select Generate Reports >

Custodian Fee Report. The Custodian Fee dialog box opens.

Billing

How do | create a
Custodian Fee Report?

Current Billing

0/5Selected -2 [

m
o

» Hame

» AVIE HERRINGE

Account Number

B -

Billing Group Name ~ Billing Period Days

in Billing Period

» Biian Lav
» COSTAL KASSNER
» Doe.Jon

» Lola Bunny

Client Actions

Note the highlighted selections

3. Select from the options for the following:

» Start Date
» End Date, and
» File format.

Generate Report

(_ Cance

Report Type
O Client Billing Summary

@ Custodian Fee Report

Start Date™

3 Months Ago

File format

Fidelity

End Date™
Month End

The default options
are shown here.

o

Deduct other fees from custodiar
| I Include debiting accounts for selected

custodian only

4. Click Run. The Custodian Fee dialog box opens.

MORNINGSTAR
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Generating Billing Reports How do | create the Insufficient Cash Accounts report?

5. Download each Custodian Fee Report, and save it to your local drive.

Custodian Fee
LPL02262018.xIs Download &
LPL02262018.xIsx Download &
TDA02262018.csv Download &
TDA02262018.txt Download ¥
SWB02262018.csv Download &
FID02262018.txt Download &
GEND2262018.csv Download ¥
6. Click Close.

7. Follow instructions from your custodian website to upload the fee report.

To ensure that an individual client or group holds enough to cash to deduct
management fees from custodian accounts, run the Insufficient Cash Account report.
This report can be run at the practice, group and individual client level.

< Note: For instructions on running the Insufficient Cash Accounts report at the practice level,
review How do | generate practice level billing reports? on page 66.

To run the Insufficient Cash Accounts report for a client, do the following:

1. Onthe Billing page, hover the cursor over the row of a client. The Actions icon is
displayed.

2. Click the Actions icon, then from the Actions menu, select Generate Reports. The
Generate Report dialog box opens.

Billing

Current Billing

0/5Selected -2 [

- Hame Account Number Billing Group Name ~ Billing Period Days

in Billing Period

» AVIE HERRINGE [l -
» Brian Lav -

'] » COSTALKASSNER  ClientActions
» Doe.Jon

Edit Billing Settings

» Lola Bunny

Click here to download

How do | create the
Insufficient Cash
Accounts report?

Note the highlighted selections

Marningstar Office Cloud January 2021
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Generating Billing Reports How do | create the Insufficient Cash Accounts report?

3. From Report Type, select Insufficient Cash Accounts. In the Report Name field, enter a
name for the report. (optional)

4. Select from the options for the following:

» Start Date
» End Date, and
» Include Money Market Fund in Current Cash Available.

Generate Report: ClientAutomation3_12 ( Cancel ) m

Report Type

Select this report.

® Insufficient Cash Accounts

Report Name*

ClientAutomation3_12_InsufficientCashAccounts_12-14-2020
Start Date* End Date*

07/01/2020 v 09/30/2020 v
The time peri selectad is 07/01/2020 to 09/30/2020

Include Money Market Fund in Current Cash Available

5. Click Run.
To run the Insufficient Cash Account report at the Group level, do the following:
1. Onthe Billing page header, select Billing Groups.
< Note: This tab is only available if you have previously created Billing Groups. For instructions
on creating Billing Groups, review Billing by Groups on page 45
2. Hover the cursor over the row of a group. The Actions icon is displayed.

3. Click the Actions icon, then from the Actions menu, select Generate Reports. The
Generate Report dialog box opens.

: = Mo,

Choose this tab.
Current Billing

0/18 Selected :O, [ | @D Select By A - Create Billing G Actio

. Account Client
] ¥ name Created Date  Account Number Name

[ | P ***Lexuan - test - 0C-6874 & 1Av20 — =

1 »**GouprTTTTTT  TTEmemes =

[ ] » *6-19 Group Billing Group Actions ZZ

[[] w13fee =

Edit Billing Settings

Advisor13 - OpenFund Qu -
Advisor13 - Dpenfund u  Calculate Fees s
Advisor13- Stock Quick & Generate Report... ==

[]  A13-Groupl

| _w Aa40 o C]

4. Follow steps 3 through 6 above.
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Billing by Groups

Overview

Billing by Groups

In some cases, you may want to combine accounts from separate households together
into a group, then bill on the group as a whole. For example, you may have a family of
clients who want to calculate account performance at the household level, but want to
bill all households together to take advantage of the lower breakpoint.

This section describes how do complete the following tasks:

» create a billing group
> assign settings to hilling group, and
» complete the billing process.

When creating a billing group, you must complete the following three steps:

1.
2.
3.

Select the accounts you want to include in the bill.

Name the billing group, and

To create a billing group, do the following:

1.

From the menu, select Billing. The Billing page opens.

MARNINGSTAR Office =

Assign a billing owner. The billing owner will receive the billing summary if posted the
Client Web Portal.

ch for Clients, Securities, Reports, and Research...

CLIENT MANAGEMENT & ANALYSIS

Clients & Accounts
ats
Prospects

Billing arting a spreadshest report on:

Redtail CAM T Your practice’s overall

» Reporting L) performance
PRACTICE MANAGEMENT

» Workspace

ntegrations [# Create Lists & Screens
mport

Securities

tatement

e290e €00 00 Minh Doscd |

Sustainable Landscape U.S

Click here to start.

Unrealized gair
for all your clie

&

Overview

How do I create a
billing group?

MORNINGSTAR
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Billing by Groups

How do | create a billing group?

2. Onthe header, click the slider next to Select by Accounts.

— Menu

Billing

Current Billing *

0/5 Selected Q. [

¥ Name Account Number Billing Group Name Billing Start
—] ¥ 9XXXX4562 — —
9XKXA562 9X(X4562 08/11/
v 9XXXX6911 == =
GBI PGB 11 08/11/

3. Select the accounts you want to include in the billing group.

Click this slider to activate
account selection.

0724 Selected - [7]  |C@ Select By Accounts]  Actions
B ¥ name Account Number Billing Group Name
¥ 9XXXX4562 =
9XKXX4562 IXXXX4562
v 9XXXX6911 =
0BT 9006911
¥ 9XXXX6986 =
9XXXX6986 9XXXX6986
¥ 9XXXX8787 =
3XXXBT87 908787
¥ Albert Einstein e
Albert Einstein 1234657
Bob Barker - IRA 35637377
? Hans Albert Einstein 8904537
[ ] Martha Einstein 29785523

Check the boxes next to the
accounts you want to include
in your group.

Marningstar Office Cloud January 2021
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Billing by Groups How do | create a billing group?

4. From the header, select the Action menu. Then select Add to New Billing Group. The
Create a Billing Group box opens.

= Billing 51

Current Billing *

3/24 Selected :Q [ (@ Select By Accounts £~ Edit Settings  Jictions v

Actions (3)

B Y Name Ac |£\dd to New Billing Group d Select this option.

5. Add or remove any accounts from the billing group.
6. In the Billing Group Name field, type the name of the billing group.
7. Click Assign a Group Owner. A box opens.

Create a Billing Group (cancel ) Enter a Billing
— Group name here.
Choose accounts from the list below to add to this billing group. To share reports run on this group, Billing Group Name® Required
you'll need to assign a client as the Group Owner.
Einstein Family
Q, Search for Clients or Accounts |+ O |
] Click here to assign
Account  Account
& |V Name Number Owner AccountType  Openl Account Name Client Name. a group owner.
A
1 8XXXX4562 9XXXX%4562 X
i 8 2 9006911 X691 X
& |V Albert Einstein 3 9XXXX6986 OXKXXB986 X
= f At 4 9000E787 XXKET8T X
Bob Barker - IRA 5637377 Einste Taxable 5 Albert Einstein Albert Einstein X
[J | Hans Albert Einstein 8904537 Einstein, Tradition... 6 Bob Barker- IRA Albert Einstein X
[J B Martha Einstein 29785523 Einstein, SEP IRA
) ¥ Alexander Hamilton Check these boxes to add
O o aoik Hemilton... Toxable or uncheck boxes remove
O pra Haitis:= Taabla accounts from the group.
O Taable Hamilton... Taxable

8. In the search field, type the name of client you want to assign as group owner. Then
click Assign.

Search to assign a client to this billing group.

Q_ Albert Einstein X |

Search for a group
(cancel ) owner here.

9. Click Save.
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Billing by Groups

How do | assign settings to a billing group?

After you create your first billing group, a separate billing group tab appears on the

billing header. To assign settings to the billing group, do the following:

1. From the header, click Billing Groups.

2. Hover over the group you want to assign settings to. Then click the Actions ... Edit

Billing Settings. The Edit Billing Settings dialog box opens.

Created Date  Account Number

|:I ¥ Test Group ® 01/21/2021 —

Billing Group Actions

Name

Advisor00Z-In

Billing Period

10/01/2020 - 12/31/2020
10/01/2020 - 12/31/2020

—  Billing

Current Billing ™ : 1

0/1 Selected :« - ©) Select By Accounts —|— Create Billing Group  ©  Actions

. Account Client

[(J ¥ Mame

Billa

How do | assign settings
to a billing group?

< fedie il ng Settings

Calculate Fees
Generate Report..
Add Fee Adjustment
Edit Billing Group

Delete Billing Group

ROvisorls - CT..

Assigning Management Fees on page 24 for instructions.

Follow the same steps to assign settings as you would for an individual household. See

Search for a group
owner here.

Edit Billing Settings: Billing Group 1 ce Save
Group's Management Fee Setting
Nane v
Fee Calculation Methodology Fee Allocation Fee Discount % (Optional)
Group Aggregate v % to Each Account v 0.00
Add Accounts to Fee Allocation
for Accaunts
Accounts
Include ir
Billing
Calculation  Name Account Number ~ F ion ing Start D Billing End Date
ol 401K = 000
@ Alice Einstein 34564 0 (@ 08/02/2016
® Haba - Schwab Stock Portfolio 0 (@ 04/27/2012
@ Hans Albert Einstein 000 (® 01/02/2008
Total 0.00

Notice that settings option
here require you to assign
at the group rather than
client level.

MORNINGSTAR
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Billing by Groups

How do | add an outside account to fee allocation?

In some cases, you may want an outside account to cover the management fees for a
group. First, you must add the outside account to the group, then assign fee allocation.

Do the following:

1.
% to each account.

Edit Billing Settings: Billing Group 1

How do | add an outside
account to fee allocation?

In the Edit Billing Settings window, from the Fee Allocation drop-down menu, select

Canc Save
Group's Management Fee Setting
None v
Fee Calculation Methodology Fee Allocation Fee Discount % (Optional) Se |ect th |S 0 p“on
Group Aggregate v | % to Each Account v | 0.00
Add Accounts to Fee Allocation
A Search for Accounts
Accounts
Include in Start Billing
Billing After 1st
Calculation Name Account Number Fee Allocation % Transaction  Billing Start Date Billing End Date
[eD)] 401K - 0.0
@ Alice Einstein 00 (@ 09/02/2016 MM/DDAYYYY
@ Haba - Schwab Stack Portfolio 0w @ 04/27/2012 MM/DDAYYYY
® Hans Albert Einstein 0w (@ 01/02/2008 MM/DDAYYYY
Total 0.00
2. Clickinside the Add Account to Fee Allocation search box. A drop-down menu opens.
3. From the drop-down menu, select the account you want to add. The account is added to
the Accounts area. Click off the menu to close.
Edit Billing Settings: Billing Group 1 Canc Save
Group's Management Fee Setting
None v
Fee Calculation Methodology Fee Allocation Fee Discount % (Dptional)
Group Aggregate v 9% to Each Account v 0.00
Add Accounts to Fee Allocation
Q  Search for Accounts
Accounts
I” I Start Billing
After 15t
ALBERT EINSTEIN'S ACCOUNTS B Mlocation% Transaction  Billing Start Date Billing End Date . .
Select this option.
I Albert Einstein I 0.00
00 (@ MM/DDAYYYY
Free Money 0 (@ MM/DDAYYYY
0 (@ MM/DDAYYYY
Martha Einstein Total 0.00

MORNINGSTAR
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Billing by Groups

How do | complete the billing process for a group?

4.

Edit Billing Settings: Billing Group 1

In the Fee Allocation % box for the outside account, type a percentage.

Cance! Save
Group's Management Fee Setting
None v
Fee Calculation Methodulogy Fee Allocation Fee Discount % (Optional)
Group Aggregate v % to Each Account ' 0.00
Add Accounts to Fee Allocation
), Search for Accounts
Accounts
Include in Start Billin
Billing After 1st
Calculation Name Account Number Fee Allocation % Transaction  Billing Start Date Billing End Date
(D) 401K — 0.00
@ Alice Einstein 34564 m @ 08/02/2016
[« ] Haba - Schwab Stack Portfolio m @ 04/27/2012 MM/DDAYYYY
[« ] Hans Albert Einstein 1 @ 01/02/2008 MM/DDAYYYY
Albert Einstein 1234657 100.00
Total 100.00

Enter a fee percentage here.

5. Click Save.

Now that you've created a group and setup fees for the accounts within the group,

calculate fees and generate reports using the same steps when completing billing for a

client. Review Calculating Management Fees on page 33 and Generating Billing

Reports on page 40 for instructions.

How do | complete
the billing process
for a group?

MORNINGSTAR
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Additional Billing Tasks Overview
Additional Billing Tasks
In some cases, you may need to perform additional billing tasks, such as adjusting a Overview
historical fee or excluding a security from management fees.
In this section, you will learn how to do the following:
» create a billing record (page 51)
» create a manual management fee (page 52)
» create a billable service (page 54)
» create a service charge (page 56)
» create a billing adjustment (page 58)
» create a payment (page 60)
» exclude a security from billing at the practice level (page 62)
» exclude a security from billing at the account level, (page 64)
» run practice level billing reports (page 66)
» identify missing prices, and (page 69)
» updating missing prices. (page /1), and
» split assets under management (page 73).
A Billing record is a billing activity that falls outside of the standard billing process. How do | create a
Billing records are created within the Billing History tab of the Billing page and include billing record?
the following:
Billing record type Billing record description
Fee There are two types of fees:
» Management fee - allows you to manually create
a management fee for accounts that are not
billed regularly or require a unique billing
circumstance.
» Billable service - which allows you to track the
number of hours worked for a client, and enter an
hourly rate charged for this service. You can also
apply a discount (by either percentage or dollar
amount) to these charges
» Service charge -which allows you to charge a flat
fee for services you provide. You cannot apply a
discount to a service charge.
Fee Adjustment Adjustments allow you to apply either a credit or a
charge to a client’s past management fees.
Payment Payments are applied when a client remits a
payment. This payment will be discounted from the
Billing Summary generated during the period in
which the payment is applied.
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Additional Billing Tasks How do | create a manual Management Fee?

Certain circumstances may require that you create a management fee manually, such How do I create a manual
as charging an account a one-time fee. To create a manual management fee, do the Management Fee?
following:

1. From the Menu, select Billing. The Billing page opens.

2. From the View drop-down menu on the header, select Billing History.

— Menu  Billing

Current Billing

0/24 Selet  View Junts  Actions ™

Current Billing </

Billing History -
oo : ST i Select this option.

3. Onthe header, click the Billing Record button. Then select Fee. The Add Fee box opens.

Billing

Billing History /

0/152 Selected | —+ Billing Record |

(] miling Add Billing Record Account Name Account

| — = Select this option.

ETF Portfolio —

Fixed Income -

Tucker Family Equities Brokerage o
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Additional Billing Tasks

How do | create a manual Management Fee?

From the Fee Type drop-down menu, select Management Fee.

From the Apply to area, select Client, Account or Billing Group.

In the Search bar, type the name of the client, account or group you wish to bill.

In the Billing Date field, enter the date you want to bill.

In the Discount field, choose whether you will apply a discount (optional).

In the Description text box, type a description of the Management Fee. This
description will appear within the Billing Summary.

Add Fee

[ Cancel | R

Fee Type

* Required fields

| Management Fee v

Apply To*

@ Client O Account O Billing Group

Bob Smith

Billing Date*
04/21/2020

Billable Balance $*
150,000.00 0.15

Effective Rate %*

Discount

@ None

(O By Amount §
(O By Percent %
Description®

Management Fee

Amount §
225.00

Enter additional
details here

Select this option.

MORNINGSTAR
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Additional Billing Tasks

How do | create a Billable Service?

Apply a billable service to charge for the hours worked for a client. You can also apply a
discount by amount or percentage. To create a billable service fee, do the following:

1. From the Menu, select Billing. The Billing page opens.

2. From the View drop-down menu on the header, select Billing History.

Billing

Current Billing

0/24 Selet  View junts  Actions
Current Billing Vv
= Billing History Select this option.
] v Account Number

3. Onthe header, click the Billing Record button. Then select Fee. The Add Fee box opens.

How do | create a
Billable Service?

Select this option.

Billing Search for Clients, Sec

Billing History /
0/152 Selected | —— Billing Record |

(] miling Add Billing Record Account Name Account
0 Mana ||:EE | = =

(@] F = =

&) -

O o

) Tucker Family —

Marningstar Office Cloud January 2021
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Additional Billing Tasks How do | create a Billable Service?

From the Fee Type drop-down menu, select Billable Service.
From the Apply to area, select Client, Account or Billing Group.
In the Search bar, type the name of the client, account or group you wish to bill.

In the Billing Date field, enter the date you want to bill.

In the Billable Hours field, type the number of hours you are charging for.
In the Hourly Rate field, type the rate you want to charge.
10. In the Discount field, choose whether you will apply a discount (optional).

11. In the Description text box, type a description of the Billable Service. This description
will appear within the Billing Summary.

Add Fee ("cancel )

* Reguired fields

Fee Type

Billable Service v Select this option.

Apply To™

@ Client O Account O Billing Group

Roop Family

Billing Date*
04/10/2020

Billable Hours* Hourly Rate® Amount §
2.00 50.00 250.00

Discount
@ Hone
O By Amount $

O By Percent %

Description®
Consultation Fees

Enter additional
details here

12. Click Save.
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Additional Billing Tasks

How do | create a service charge?

Create a service charge to apply a flat fee for a client. To create a service fee, do

the following:

1. From the Menu, select Billing. The Billing page opens.

2. From the View drop-down menu on the header, select Billing History.

Billing

Current Billing

0/24 Selet View

Current Billing

v

Billing Histary

At e Select this option.

3. Onthe header, click the Billing Record button. Then select Fee. The Add Fee box opens.

Billing

Billing History /

0/152 Selected

Billing Record

Search for Clients, Sec|

[ Billing

Add Billing Record

Account Name Account

How do I create a
service charge?

Fee

Payment

Fee Adjustment

Tucker Family

Select this option.

MORNINGSTAR
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Additional Billing Tasks How do | create a service charge?

From the Fee Type drop-down menu, select Service Charge.

From the Apply to area, select Client, Account or Billing Group.

In the Search bar, type the name of the client, account, or group you wish to bill.
In the Billing Date field, enter the date you want to bill.

In the Amount field, type the amount you want to charge.

In the Description text box, type a description of the Service Charge. This description
will appear within the Billing Summary.

Add Fee (Cancel )

* Required fields

Fee Type

Service Charge V. Select this option.

Apply To™

@ Client O Account O Billing Group

Roop Family

Billing Date*
04/10/2020

Amount §%

250.00

Description®

Consultation Fees

Enter additional
details here.
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Additional Billing Tasks How do | create a billing adjustment?

Adjust a fee by applying a credit or a charge to a management fee previously paid by a How do | create a hilling
client. To create a billing adjustment, do the following: adjustment?

1. From the Menu, select Billing. The Billing page opens.

2. From the View drop-down menu on the header, select Billing History.

— Menu  Billing

Current Billing

0/24 Selet  View junts  Actions
= Select this option.
Current Billing Vv
B Billing Histary
[ A Account Number

3. Onthe header, click the Billing Record button. Then select Fee Adjustment. The Add
Fee Adjustment box opens.

Billing Search for Clients, Sec

Billing History /

0/152 Selected ¢~ Billing Record

(] miling Add Billing Record Account Name Account

]
m

Fee
F

|

ee Adjustment — —

Select this option.

|
m o m

Payment

3
o
=]
-
I

3
@
i)

Tucker Family
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Additional Billing Tasks

How do | create a billing adjustment?

9.

From the Apply to field, select Client, Account or Billing Group.

In the Search bar, type the name of the client or account you wish to adjust for.

From the Adjust For field, select the Management Fee you wish to adjust.

From the Adjustment Type area, select Charge or Credit.

From the drop-down menu, select by Amount or Percentage. Then type the figure in

the text box below.

From Date, type the date you want to post the adjustment.

10. In the Description text box, type a description of the adjustment.

@ Client O Account O Billing Group

Roop Family

Adjust For®
Management Fee on 2013-12-31 for §74.85

Adjustment Type*
O Charge @ Credit

By Amount v $25.00

Date*®

04/10/2020

Description®

Qver payment

11. Click Save.

Add Fee Adjustment ( Cancel )
Apply To* " Required fields || Enter adjustment

details here.

MORNINGSTAR
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Additional Billing Tasks

How do | create a payment?

Create a payment when a client remits payment by credit card, cash, check or money
order. To create a payment, do the following:

1. From the Menu, select Billing. The Billing page opens.

2. From the View drop-down menu on the header, select Billing History.

Billing

Current Billing

0/24 Selet  View junts  Actions

Current Billing Vv

Billing History o
[ : Account Number Select this option.

3. Onthe header, click the Billing Record button. Then select Payment. The Payment
window opens.

Billing Search for Clients, Sec

Billing History /

0/152 Selected P+

[==]

ing Record

[] Biling Add Billing Record

]

Account Name Account

na  FBE — =

Fee Adjustment — —

How do | create
a payment?

Payment

3
o
=]
-
I

3
@
i)

Tucker Family

Equities Brokerage o

Select this option.

MORNINGSTAR
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Additional Billing Tasks

How do | create a payment?

4. From Apply to, select Client, Account or Billing Group.

5. Inthe Search bar, type the name of the client, account, or group you wish to apply

a payment.

In the Billing Date field, enter the date you want to bill.
From the Payment Method field, select Credit Card, Check, Cash, or Money Order
In the Amount area, type the amount the client paid.

In the Description text box, type a description of the Payment. This description will
appear within the Billing Summary.

Add Payment

( Cancel ) G

Apply To™

Roop Family

@ Client O Account O

* Reguired fields
Enter payment
details here.

Billing Date*
04/10/2020

@ Credit Card

Payment Method Amount §*

Reference # (Optional)

Description®

Consultation Fees

10. Click Save.

MORNINGSTAR
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Additional Billing Tasks How do | exclude securities from billing at the practice level?

How do | exclude
securities from billing
at the practice level?

In some cases, you may choose to exclude a security from billing across your practice.
For example, if your firm does not charge against cash you can exclude cash holdings
for all clients and accounts. To exclude a security from billing at the practice level, do
the following:

1. From the Menu, select Billing. The Billing page opens.

Home

MAORNINGSTAR Office <=

Marningstar Research

St ch for Clients, Securities, Reports, and Research...

CLIENT MANAGEMENT & ANALYSIS

Clients & Accounts

ats
Prospects
Billing |S‘T ng a spreadsheet report on:
Redwall CAVI N Click here to start.
N - # >  Your practice's overall 7 Unrealized gait
* Reporting [ ] performance = for all your clie
PRACTICE MANAGEMENT
» Workspace
ntegrations [# Create Lists & Screens [
mport o _
Market Value e 14
Securities — —
$4,163471.08 List |
041 List I
9.29 1S Lis l

2. Click Actions > Exclude Securities from Practice. The Exclude Securities from All
Accounts dialog box opens.

— Billing

Current Billing

0724 Selected :Q [ (

) Select By Accounts

Actions

(] ¥ Name Open Fee Management Name

Generate Practice Report...

¥ AVIE HERRINGE

508103357 - ROTH IRA

Exclude Securities from Practice

Click here to start.

Create Billing Group

Add Fee Adjustment

3. In the Search for a security to exclude field, type the name or security identifies
(such as ticker) for the security you want to exclude. A list if choices dynamically
appears.
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Additional Billing Tasks How do | exclude securities from billing at the practice level?

4. From the list of securities, click the security you want to exclude. The security you
selected appears within the Excluded Securities column.

Exclude Securities From All Accounts ( Cancel )

Select securities in your practice Excluded Securities

|- Q, appl X | (i) Keep in mind. changes you make here will override any account-specific exclusions.
Name Identifier Exchange Type

[Appleinc — aapL  nasDaQ  stock |
Applelnc  AAPL SANTIAGO  Stock

Be sure to identify the
correct exchange when
identical names and tickers
appear for a security.

% & s & § You haven't excluded any securities from billing yet
T TZIIIUSNZTS
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Additional Billing Tasks

How do | exclude a security at the account level?

5. Click Save.

6. To remove the security from the Excluded Securities list, click on the X next to

the security.

Exclude Securities From All Accounts

Select securities in your practice

Q3 Search for a security to exclude

Excluded Securities
(i) Keep in mind, changes you make here will override any account-specific exclusions

Apple Inc | AAPL

7. Click Save.

In addition to excluding securities from billing across your practice, you can also

exclude securities for individual accounts.
do the following:

To exclude securities for individual accounts,

1. From the Menu, select Billing. The Billing page opens.

Home >
MARNINGSTAR Office =
Merningstar Research
R ch for Clients, Securities, Reports, and Research...
CLIENT MANAGEMENT & ANALYSIS
Clients & Accounts
ats
Prospects
Billing arting a spreadsheet report on:
Tedial CAT Click here to start.
/;\/‘ Your practice's overall 7 Unrealized gair
» Reporting [ ] performance \/Z/)  forallyour clie
PRACTICE MANAGEMENT
» Workspace
Tt ieries [# Create Lists & Screens |
port Market Value Type 14
Securities —
List l
Current Statement List |
2 Sustainable Landscape U.S List |
! non TR S

Click here to remove the
security from the Excluded
Securities list.

How do I exclude a
security at the
account level?

MORNINGSTAR
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Additional Billing Tasks

How do | exclude a security at the account level?

2. Click the slider next to Select by Account.

3. Click the Locate button. The Locate box opens.

4. In the Search Client/Account field, type the account you want exclude a security for. A

list of choices dynamically appears.

5. From the list of accounts, select the acecount you want to exclude securities for.

— Menu  Billing
Current Billing v/
(@ Select By Accounts ~ 0/76 Selected [ Export All | :Q
Lacate
"] ¥ Name Accour \| o Sxi
v 9000562 = - i
THO562 goop _ame ¥pe
¥ 9000911 e Accounts
—— -
e PO gxxxean Accounts
¥ 9XXX6386 ==
9XXXX6986 9K IXXXXB9B6 Accounts
VIO o goKare? Aecounts
GHHNXBTBT GXXXK
¥ Albert Einstein 25
( Albert Einstein 2Billing Groups v 04/06/2004 0
[ Bob Barker - IRA 2 Billing Groups Vv 10/02/2012 0

6. Forthe selected account, click the Actions menu. Then select Exclude Holdings from
Account. The Exclude Holdings box opens.

1/76 Selected  Actions v

- ) r
A Bxport |

m

B Y Name

Account Number

Billing Group Nam

Select the correct
account here.

gXHxXX4562 | 9HxKX4562 Einstein Famil
¥ IXXXX6911
OXXXBI 11 Transactional Accouny Actions Einstein Famil
¥ 9XXXX6986 T :
9X00XX6388 E RN SFDRG: Einstein Famil
v 9XXXXB787 Exclude Holdings From Account h———
gXHXX8787 9XXXX8787 Einstein Famil

¥ _Albert Einstein

Select this option.

MORNINGSTAR

Marningstar Office Cloud January 2021
© 2021 Morningstar. All Rights Reserved.

65



Additional Billing Tasks How do | generate practice level billing reports?

7. In the Search for the holding to exclude field, type the holding you want to exclude.

Exclude Securities for 573403145 - INDIVIDUAL ( Concdl )

Chaoose securities from the list below to exclude from your Excluded Securities
billing and fee calculations.

Q. Search for a security to exclude 15hares 1-3 Year Treasury Bond ETF | SHY X

(] cask

| iShares 1-3 Year Treasury Bond ETF | SHY] |

[_] Fidelity® Government Cash Reserves | FORXX

8. Click Save.

After you generate billing fees, you have the option to run practice-level billing reports
to ensure that your billing records are accurate. Practice-level billing reports include
the following:

This Report ... Contains this information ...

Insufficient Cash Account » Clients accounts billing data and list the
accounts that do not have sufficient cash to
deduct the fee amount, and

» Insufficient account information, including fee
amount to be billed, current cash available in
account & cash deficit.

< Note: If Money Market Funds are not
included, only calculate free cash available
in the accounts.

Management Fee Excluded Holdings | Holdings that are marked as excluded from
management fees or unmanaged.

The following accounts are excluded from
this report:

v

accounts held in inactive client
accounts held in shared clients
accounts owned by a prospect, and

» accounts exclude from client aggregate.

v

v

Select this option.

How do | generate
practice level
billing reports?

Marningstar Office Cloud January 2021
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Additional Billing Tasks

How do | generate practice level billing reports?

This Report ...

Practice Billing Summary

Contains this information ...

Practice-level billing information for all billing
clients, accounts and groups, including;

» Applied fee calculation methodology
» Assigned management fee

» Billable balance, and

» Allocated fee amount.

If you want to include additional charges and
rebates within the billable balance and
allocated fee amount calculation, check the
Include additional charges and rebates hox
in report settings.

Management Fee Excluded Accounts

All accounts marked as excluded from billing or
unmanaged

Account data points displayed are advisor name,
client name, account name and account number.

< Note: Account under prospects, inactive clients,
shared clients, as well as accounts excluded from
client aggregate are not included.

Practice Management Fee

All billing clients, groups and accounts with their
corresponding fee calculation settings.

The billable balances, firm fees, advisor fees and
total fee amounts include all management fee and
adjustment billing records.

Fees display for each account, without fee
allocation settings.

MORNINGSTAR
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Additional Billing Tasks How do | generate practice level billing reports?

To run this report, do the following:

1. From the Menu, select Billing. The Billing page opens.

Home
MARNINGSTAR Office =
Marningstar Research
it ch for Clients, Securities, Reports, and Research...
CLIENT MANAGEMENT & ANALYSIS
Clients & Accounts
ats
Prospects
Billing Ié", ng a spreadshest report on
Redtell CAM > Your practice’s uverall Unrealized gait )
» Reporting {T)  performance for all your clie Click here to start.
PRACTICE MANAGEMENT
e [# Create Lists & Screens |
mport Name o L
Securities —
My New List List |
Current Statement List I
Sustainable Landscape U.S List l
2 20 con o Linh Dosad | R c

2. Onthe header, click Actions > Generate Practice Report. The Generate Practice Report
box opens.

— Billing

Current Billing

0/24 Selected Q. [ (@ Select By Accounts
Actions
[J ¥ name Open Fee Management Name

Generate Practice Report...

¥ AVIE HERRINGE Click here to start.

502103357 - AOTH [RA Exclude Securities from Practice

18- JOINT-WITH RIGHTS (  Create Billing Group

750 - INDIVIDUAL Add Fee Adjustment
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Additional Billing Tasks How do | know if prices are missing when generating a bill?

3. Inthe Report Name field, select the report you want to run.

< Note: the report name will include the date and name of the report by default. Select the time
period for which you want to run the report.

Generate Practice Report { Cancel ) m
Report Type
| Select from these
Insufficient Cash Accounts v options.
Management Fee Excluded Holdings
Management Fes Excluded Accounts
Practice Billing Summary
Practice Management Fee
Create for®
All Advisars v
4. Click Run.
When generating a client bill for a single client or multiple clients at once using How do I know if
Batch, a missing price warning now appears to alert you that your fee data may be prices are missing
inaccurate. Use this warning to identify positions with missing prices, validate the when generating a bill?
correct prices with your custodian, and, when necessary, update prices within
Morningstar Office Cloud.

the Missing Price warning only appears under the following circumstance:

» Fee data has not been calculated within the Current Billing grid. Fee data is
automatically calculated when the billing summary is generated.

» Fee data has been calculated within the Current Billing grid, but the Overwrite
existing management fee billing option is selected when generating the billing
summary.

< Note: The missing price warning functionality will be enhanced in future releases.
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Additional Billing Tasks How do | know if prices are missing when generating a bill?

To view missing price data, do the following:

1. Hover over the client you want to run a bill for. Then click the Actions > Generate
Reports. The Generate Report box opens.

— Billing

Current Billing ~

» Roop Family

» Johnson Family

Adjust Billing

) Select By Acco Q

» Name Account Number Billing Group Name|
» Albert Einstein 22, Can Edit -
» Alexander Hamilton g

Bayly Family Actions
» Haba Famil fE

y. Edit Billing Settings

» J.R.R. Tolkien

Jennifer Roop Caleulats
» John Keats Generate Reports

Select this option.

» Sample Client =

2. From the Billing Options area, select Overwriting existing management fee data.

Generate Report (_ Cancel

Report Type
@ Client Bi ing Summary

() Custodian F

Report Name*

A4598 Rita's individual client_BillingSummary_05-18-2020

Start Date™
2020-04-01 i

End Date®

2020-04-30 v

e existing management fee datg

ud

3. Click Run.

4. If prices are missing, the following warning message appears. Click Review. The Report
Warning window opens.

Your report is ready, but there's data that may need your attention

Current Billing

y impact the accuracy of this report, so we recommend you review

© ) Select B s | 0/50 Selected [} Export A

Select this billing option.

Fee

] ¥ Neme Market Value Date  Ad

Account Numbe

Days in Billing Period

Billable Balance SUSD Market Value SUSD

Click this button.

Marningstar Office Cloud January 2021
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Additional Billing Tasks

How do | adjust a price?

5. Verify the correct prices with your custodian.. To download for record keeping purposes,

click the download icon.

Report Warning: A4598 Rita's individual client_BillingSummary_05-18-2020 |£|

The following items may impact the accuracy of this report. Please review them before sharing

¥ Missing security prices replaced

We used the most recent available price to calculate market value for this report. Verify
the correct security price with your custodian

Missing Price  Most Recent

Security Name Symbol / CUSIP Date Price Date

Price Source

BlackRack Glabal Allocation Inv A MDLOX 04/30/2020

02/27/2020  Impart / Manua

- MDLOX - - Impart / Manual

Account Name
A

Account Number
& (=

d

If you discover a price is inaccurate, you can adjust the price within the Securities

page. To adjust a price, do the following:

1. From the Menu, select Securities. The Securities page opens.

Home

EXPLORE

MAORNINGSTAR Office <=

Merningstar Research

a2 ch for Clients, Securities, Reparts, and Research...

CLIENT MANAGEMENT & ANALYSIS

Clients & Accounts

ats

Prospects

Billing arting a spreadshest report on:

i g #  Your practice's overall Unrealized gair

» Reporting [ ] performance for all your clie

PRACTICE MANAGEMENT

» Workspace

Integrations [# Create Lists & Screens [

Import T

oo L

Securities —
My New List lst | Click here to start.
Current Statement List |
Sustainable Landscape U.S List l
Lk Dovod | c

2. From the header, select either the Custom Securities or Morningstar Securities tab.

3. Onthe header of the selected tab, in the Search for Securities text box, type the

security you want to adjust.

Click thisicon
to download.

How do I adjust a price?

MORNINGSTAR
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Additional Billing Tasks

How do | adjust a price?

4. Hover over the security you want to adjust a price for. Then click the Actions > Edit. The
Edit Source Preference box opens.

=  Securities
[EEINHETREINTEN |znage price and asset class preferences for Morningstar tracked securities in your practice

Security Name Ticker/Symbal Security Type Price Source Classification Source

I

BlackRock Global Allocation Inv A () MDLOX Open-End Fund Custaodian Price Custom
Actions
Edit
Delsts

Enter the name or symbol
of a security here.

5. From Price Source, select Custodian. Then click the + sign to enter a new row.

6. For the date you want to change a price for, enter the date, and price.

Edit Source Preferences

Price Source

Custodian

BlackRock Global Allocation Inv A

Price Information

Date Range

02/19/2020 to

05/19/2020 ( Apoly )

[} ate Price )
and price here.
15/13/2020 10
02/27/2020 10
7. Click Done.

Select this option.

Enter updated date

MORNINGSTAR

Marningstar Office Cloud January 2021
© 2021 Morningstar. All Rights Reserved.

72



Additional Billing Tasks How do | split assets under management?

In some cases, you may choose to split a client’s assets under management with How do | split assets
additional members of your firm, allowing multiple firm member to charge a under management?
percentage of the client’s assets when billing.

This feature allows users to divide the assets of a transactional account among a
maximum of five firm members. Before an account's assets can be split, the client must
be shared with the firm members for whom the AUM will be split.

To share a client, do the following:

1. From the Menu, select Clients & Accounts.

Home
MAORNINGSTAR Office =
Marningstar Research
fie ch for Clients, Securities, Reports, and Research...
CLIENT MANAGEMENT & ANALYSIS
Clients & Accounts |
prts q

Prospects Click here to start.
Billing arting a spreadshest report on:
Hetaiei > Your practie's overal (57 Umealied i
» Reporting L) performance W/} ferallyour clie
PRACTICE MANAGEMENT
» Workspace
egrations Lists & Screens [
mport e A
Securities —

List l

List I

scape U.S List l
¢ on Lok Dosod)

2. Hover the cursor over the client you want to share. The Action icon appears.

3. From the Actions drop-down menu, select Share. A dialog box opens.

Chents & Accounts

Active Clients ++ for 1A Test12 (Admin)

Q [4 Expont A

() Name Market Value (USD)  Market Value Date Client/Account Type  Primary Benchmark

i
[] » aaaaJackson Wu135 20,000.00 12/11/2020 Clients Global Default
(] Admin12 - Institution Client - Active 2g 000 — Institutions Global Default
[l Admin12 - Institution Client - Inactive Do0 — Institutions Global Default
[ ] ¥ Advisor1Z - BillingClientD01 (&) 21,960.00 12/11/2020 Clients Global Default
(] al 2106000 12711/2020 Taxable Client Default
[] ™ Advisor12- BillingClient00Z  Actions 12/11/2020 Clients Glohal Default
(] Anurag Naik — Clients Global Default
] Ashutosh Client ’l = Clients Glohal Default
(] ClientAutomation3_12 b - Clients Global Default
] ClientAutomationd_12 C arta R - Clients Global Default
M Created admin 12_Test DO = = Eliemts Tiotrat-Brefmtt
] »ciz TWE 1211172020 Clients The Capital Srength TRU. Goloct this option.
() IAT1Client ShareTo  BgCan  ~CC AL 1 — Clients Global Default
(W] IA12Client ShareTo13 — Clients Global Default
] IA13Client ShareTo12 CanEi - Clients Global Default
B IA13Client ShareTolAZ Reat : = Clients Glohal Default
[ | IAI3JACKSON Create/tdit Hany — Clients Global Default
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Additional Billing Tasks

How do | split assets under management?

4. In the Share dialog box, click inside the Search field.

5. From the Colleagues drop-down menu, select the member or members for which you

want to share the client.

Share: Advisor12 - BillingClient001

e automation Nerts team

6. Click Share.

Click inside this search box.

After you successfully share a client record, you can split assets amongst firm members
you've shared the client with. Assets can be split at individual account level only, and
they must be split from the original client owner's log in.

To split assets amongst firm members you've shared the client with, do the following:

1. Click the caret next to the client for which you want to split assets.

2. Hover the cursor over an account record.

3. From the Actions drop-down menu, select Edit Account profile/settings. A dialog box

opens.

Clients & Accounts

MORNINGSTAR

Active Clients v for 1A Test12 (Admin)
Q [4 Expon A
] Name Market Value {USD) Market Value Date Client/Account Type Primary Benchmark
i
[]  w aaaalackson Wul35 20,000.00 12/11/2020 Clients Global Default
O Admin12 - Institution Client - Active 2o 000 — Institutions Global Default
O Admin12 - Institution Client - Inactive 0.00 — Institutions Global Default
[] ¥ Advisor12 - BillingClientD01 Ss, 21,960.00 12/11/2020 Clients Global Default
0O n © 21.86000 12/11/2020 Taxable Glient Default
[ ] ™ Advisor12 - BillingClient002 21080 N0 12/11/2020 Clients Global Default
[ Anurag Naik Transactional Account Actions — Clients Global Default
| Ashutosh G fobe-Beiadt
O ClientAutomation3_12 = Clients Global Detault Select this option
M) ClientAutomationd_12 — Clients Global Default
O Created admin 12_TestDOP  _ — Clients Global Default
] »C 2 12/11/2020 Clients The Capital Strength TH
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Additional Billing Tasks How do | split assets under management?

Choose a percentage for the
original client owner.

4. In the Edit Account box, click Settings.
5. Check the box next to Split account’'s AUM with other advisors in firm.
6. In the Advisor Name drop down, select the client owner’s login in.
7. In the AUM percentage text box, type a percentage. Then click Add advisor.
Edit Account : t1 (cancel )
Profile Primary Benchmark *Required
Settings > Client Default 0y
Secondary Benchmark (Optional) QD Displa
Tertiary Benchmark (Optional}
Model Portfolio
Client Default v
¥ solicac her advisors in firm
Advisor Name Advisor/Rep Code AUM %*
|4 Test12 v 50.00
Total 50.00
8. Inthe Select an advisor drop-down menu, select the advisor you shared the
account with.
9. In the AUM percentage text box, type a percentage.
Edit Account : t1 ( Cance .‘
Profile Primary Benchmark *Required
Senings > Client Default Q
Secondary Benchmark (Optional) QD Displ
Tertiary Benchmark [Dptional) QD Displa
Model Portfolio
Client Default v
Advisor Name riRep L} AUM %=
1A Test12 v 50.00
Test15 1A A\ 50.00
Totzl 100.00

10. Click Save.

Be sure that the
AUM% totals 100%.
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Additional Billing Tasks How do | calculate fees for clients with split AUM?

Once your client is shared with firm members, and assets are split, you can then How do | calculate
calculate fees for the most recent billing period by the percentage owned by each fees for clients with
advisor. This action must be completed for all advisors that share the client’s assets. split AUM?

Do the following:

1. From the Billing grid, click the caret next to the client for which you want to split assets.

2. Validate that the Split AUM flag appears next to the account for which you've split
assets.

3. Hover the cursor over an client record.

4. From the Actions drop-down menu, select Calculate Fees. A dialog box opens.

= Billing

Current Billing *

0/68 Selected 2[4 | @D Select By Accounts | Actians \/

> Name Account Number Billing Group Name

» Admin11 - Active Client 102 °% Can Edit =
Admin12 - Institution Client - Active —

Admin12 - Institution Client - Inactive —

¥ Advisor1? - BillingClient001 | ® |-
t1 (Split AUM]
» Advisor12 - BillingClient ~ Client Actions
» Advisor13 - BillingClient
» Advisor13 - ClientWith0
» Advisor13 - ClientwithT | Calculate
Anurag Naik Generate Report
Ashutosh
» Bob Smith

Edit Billing Settings

Fees — Select this option.

Add Fee Adjustment

5. From the Choose a Billing Period menu, select Most Recent Billing Period.

Calculate Management Fees If'_ Cancel '_'} @

Choose a Billing Period
| Most Recent Billing Period v | Select this option.

Overwrite existing management fee data

6. Click Run.

Once fees are calculated, the individual advisor portion of the split fee is displayed
within the Calculated Data section of the Billing grid for each advisor.
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